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Before starting to describe the implementation of the ReSUS components, some general points should 

be considered:  

 Simple methods, such as set or get methods, are not described in this manual. The name of 

the method is informative enough to describe its application  

 In order to distinguish the name of methods, parentheses are included right after their names. 

For example, the “main” method is described as main()  

 The simulation and its configuration are defined in an XML file. The Core component of the 

ReSUS Platform will read, processed and perform the simulation steps which are described by 

XML nodes in the XML files   

 Simulation items are implemented as distinct classes in the ReSUS Platform. The configurations 

of these classes are stored within XML files. The parse() method reads the nodes of XML file 

and inset them in their corresponding attributes. Figure 1 depicts the operation of the parse() 

method where the properties of an Input Provider are transferred into the attributes of an 

object of InputProvider class 

 

Figure 1. the process of parsing the XML nodes into the attributes of classes by parse() method 

 The constant strings defined for the parse() method enable the attributes of the classes to be 

recognized in the corresponding XML file. The names of these constant strings consist of the 

name of the attribute and a NodeName postfix. For example, the XML node <inputFileName> 

is utilized to introduce the inputFileName attribute of its corresponding class. In order to guide 

the parse() method to find the <inputFileName> node and transfer its value into the 

inputFileName attribute, a constant string with the name of inputFileNameNodeName is 

defined and its value is set to “inputFileName”. It is worth mentioning that constant strings of 

each class are initialized by the init() method of that class, which will be invoked within the 

constructor of the class 

Hint: the design issues and architecture of the components and items of the ReSUS Platform are 

introduced in (Ghofrani J. , 2016) and are described in the User Handbook of ReSUS (Ghofrani & Li, 

2016). 

Hint: in order to make it easer to find the clicks and inputs in the described instruction in this document, 

the items which should be clicked or selected are written in bold. The values which should be typed or 

entered by the user are also written in italic. 
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1 Software Components 

ReSUS consists of three main components, which are introduced in (Ghofrani J. , 2016). These 

components function together to design, perform and analyze the probabilistic simulation workflows. 

This handbook describes the internal structure and working mechanism of these components.  

1.1 Core  
Core is a Qt project developed in C++. As depicted below, the content of the Core.pro file specifies the 

structure and components of this project. The assigned value to the TEMPLATE keyword in the 

configuration (.pro) file (which defines the type of the project) specifies that this project consists of 

three subprojects as subdirectories. These subdirectories are listed underneath SUBDIRS keyword as 

the next line of configuration file (core.pro).  

The content of the Core.Pro file  
 
 
TEMPLATE = subdirs 
SUBDIRS += \ 
    ResusCore \ 
    ResusCoreTests \ 
    ResusCoreLib 
 

 
 

Note that the core memory the core is responsible to make a mapping of the simulation workflow, 

which is designed within GUI, into the memory and perform the probabilistic simulation on it.  

1.1.1  ResusCore subproject 

The ResusCore subproject is located in a folder with the same name under the Core project folder. Like 

other Qt projects, it contains a project file (a file with the .pro extension), which its content is described 

as the following:  

 The first 5 lines of the project file introduce the general configurations of ResusCore subproject 

as a console application without bundles and Qt dependencies. The TARGET keyword specifies 

the name of the executable file of the application which will be generated after compiling and 

linking. In this case it will be named resusCore.exe 

TARGET   = resusCore 
CONFIG  += console 
CONFIG  -= app_bundle 
TEMPLATE = app 
CONFIG  -= qt 
  

 The INCLUDEPATH keyword specifies the paths, which should be searched by compiler for 

#include directive. The values below show the relative paths to the header files (*.hpp or *.h) 

of the added libraries into the ResusCore subproject (ResusCoreLib, Boost and HDF) 

INCLUDEPATH+= $$PWD/../ResusCoreLib 
INCLUDEPATH+= $$PWD/../../boost_1_55_msvc12_32bit 
INCLUDEPATH+= $$PWD/../../hdf5_1.8.12/include  

 The list of libraries and their relative paths, which should be linked into the ResusCore project 

are defined by LIBS keyword. These files will be used by linker to generate the executable of 

the project. The -L flag notifies the linker that the value is a path and the -l flag guides the linker 

to the library file 
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LIBS += \ 
   -L$$PWD\..\..\boost_1_55_msvc12_32bit\stage\lib\ 
LIBS+=\ 
    -L$$PWD\..\..\hdf5_1.8.12\lib -llibhdf5_cpp -llibhdf5 -llibszip -
llibzlib -llibhdf5_hl 

win32:CONFIG(release, debug|release): LIBS += -L$$OUT_PWD/../ResusCore-
Lib/release/ -lResusCoreLib 
else:win32:CONFIG(debug, debug|release): LIBS += -
L$$OUT_PWD/../ResusCoreLib/debug/ -lResusCoreLib 

 

 The SOURCES keyword specifies the list of assigned source files to the ResusCore subproject. 

This list contains only one C++ source file with the name main.cpp  

SOURCES= main.cpp\   

The $$PWD keyword as a part of the paths (LIBS and INCLUDEPATH) in the ResusCore.pro file specifies 

the full path leading to the directory containing this file. The boost and HDF libraries are located in two 

levels above the ResusCore project folder in the filesystem (this relative path is addressed by 

$$PWD\..\..\). Since the ResusCoreLib is a part of the Core project, the generated libraries will be placed 

in the same path, in which the output folder of the ResusCore project is located. The generated files of 

the ResusCoreLib, which are used as library in ResusCore project, are located in a sibling folder of the 

ResusCore subproject output folder. These library files are located under a folder in upper level of the 

output folder of ResusCore subproject. The $$OUT_PWD/../ Expression specifies the path to the folder 

in the upper level related to output folder of the ResusCore project (See Figure 2). Note that, the 

$$PWD keyword contains the path to the configuration file in source of the ResusCore subproject and 

the $$PWD_OUT presents the path to the output of the ResusCore subproject after compile.  

 

Figure 2. Related Paths in output folder of the resusCore subproject 

 

The main.cpp contains the main() method as the starting point of Core and the resusCore project 

respectively. This method parses the command line arguments which should be passed to 

resusCore.exe. The first argument in the command line after the resusCore.exe should be a full path to 

an XML file.  Further command line arguments are some switch values which specify the number of 

threads or activate the debug mode. Activating the debugging mode allows the user to run the 

simulation as uncontentious discrete steps (running step by step). The main() method will parses the 

given command line arguments and  send them as input parameter to the constructor method of 

Simulator class.  After validating the command line arguments, the main() method invokes the 

parseXML() and simulate() methods  of the instantiated object of Simulator class resepctivly.  

Once the execution of the simulate() method is over, the main() method calculates and prints the 

duration of simulation.  

ou 

$$PWD_OUT/../ 

$$PWD_OUT 

$$PWD_OUT/../ResusCoreLib 
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1.1.2  ResusCoreLib subproject 

The ResusCoreLib subproject contains the significant components of the Core project. This subproject 

is located as a subfolder under the Core project folder. The ResusCoreLib project generates a static 

library (.lib file) which can be used in other projects. In our case, the library is assigned to the ResusCore 

subproject to fulfill the simulation tasks. Furthermore, the methods and classes in this library can be 

tested by the provided test suit in ResusCoreTests subproject. The content of this file is described as 

following:  

 As listed below, the ResusCoreLib.pro does not need to include a Graphical User Interface 

(described below in the first line) and should generate a static library, which is specified through 

the CONFIG keyword and the TEMPLATE keywords 

QT       -= gui 
 
TARGET = ResusCoreLib 
TEMPLATE = lib 
CONFIG += staticlib  

 The LIBS keyword specifies the path to the library files which are assigned to this subproject 

and the INCLUDEPATH keyword introduces the path to their header files  

INCLUDEPATH+=$$PWD\..\..\prclib\inc 
LIBS += \ 
   -L$$PWD\..\..\prclib\lib -lpcre3 -lpcreposix3 -lpcre3d -lpcreposix3d 
 
 
INCLUDEPATH+= $$PWD/../../boost_1_55_msvc12_32bit 
LIBS += \ 
   -L$$PWD\..\..\boost_1_55_msvc12_32bit\stage\lib\ 
 
 
 
INCLUDEPATH+=C:\hdf5\include 
 
LIBS+=\ 
    -LC:C:\hdf5\lib -llibhdf5_cpp -llibhdf5 -llibszip -llibzlib -
llibhdf5_hl  

 The header and source files which are listed under HEADERS and SOURCES keywords introduce 

the attaches classes to the ResusCoreLib subproject. The structure of these classes will be 

introduced in following subsections  

1.1.3  Simulator 

The objective of the Simulator class is to moderate the execution of the probabilistic simulations. It 

parses the configurations of the simulation from an XML file, and instantiates and initializes the 

corresponding objects in the memory and then it arranges the instantiated objects as a chain. Finally, 

the Simulator starts to traverse the chain from first item in the chain to the final item iteratively. Each 

object in the chain is assigned to perform a part of the simulation, such as loading an input from file 

into memory or executing an assigned executable to the simulation workflow. This operation will be 

performed in a loop till all the objects in the chain have nothing to process.  

The attributes of this class are explained in Table 1. 

Table 1. Attributes of the Simulator class 

Type std::vector<IOProvider*> 

Name IOProviders 
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Description a vector of pointers to the InputProvider objects in the simulation workflow which will 

be generated by ParseXML() method 

Type std::vector<ResultConverter*> 

Name resultConverters 

Description a vector of pointers to the ResultConverter objects in the simulation workflow which 

will be generated by ParseXML() method 

Type std:vector<Model*> 

Name Models 

Description a vector of pointers to the Model objects in the simulation workflow which will be 

generated by ParseXML() method 

Type boost::thread_group 

Name tgroup 

Description if the number of threads is greater than 1 (specified by the NumberOfThreads 

attribute), the tgroup will be used to make a group of threads, assign the runModell() 

method to them and run the threads simultaneously  

Type std::string 

Name xmlFileName 

Description the full path to the XML file which contains the items, configuration and structure of 

the ReSUS simulation 

Type bool 

Name stepByStep 

Description this switch makes it possible to run the simulation in the step-by-step mode instead 

of continuous loop   

Type int 

Name numberOfThreads 

Description specifies the number of threads which should be generated to run the simulation in 

parallel mode. In normal mode (single thread), this value will be set to 1 

 

The corresponding methods to realize the functionalities of this class are described below:  

 simulator(string xmlFileName, string xsdFileName, int numberOfThreads, bool 

stepByStep=false): is the constructor of the Simulator class which initializes the attributes of 

this class. The initial values will be sent via input parameters of this method. In our case, the 

main() method in resusCore subproject invokes this method by instantiating an object of the 

Simulator class 

 void init(): initializes the constant strings, which will be used by the ParseXML() method. These 

constant strings specify the required texts for recognizing the corresponding XML nodes to the 

attributes of the Simulator class  

 int parseXML(): reads XML tree from the XML file, which is specified by xmlFileName attribute, 

and instantiates the required objects according to the content of the file. This method 

recognizes the related tags to the simulation items within the XML tree (e.g. <model>, 

<inputProvider> or <resultConverter>) and instantiates an object from the related class to the 

XML node (e.g.  objects of Model, inputProivder or resultConverter classes). The rest of the 
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parsing progress are left to the parse() method of the instantiated object. The parseXML() 

method invokes the parse() method on each instantiated object by passing  the current XML 

node as parameter to them. The invoked parse() method reads the contents of XML node and 

converts them into the values of the attributes of the instantiated object (e.g. file name, 

working directory etc.). In addition, parseXML() method parses the <Connections> node. 

Although these nodes will not be mapped into any classes, the provided data in <Connection> 

tags will be used to connect the simulation objects together. For this purpose, the parseXML() 

method uses the start and end points which are defined in the <Connection> tags. By invoking 

orderModelChain() method as the last command in ParseXML() method, the instantiated 

object in the memory, which are already initialized and connected, will be ordered. More 

details are available in the description of the orderModelChain()  method 

 bool validate(): invokes the Validate() method of the simulation objects, which are parsed and 

instantiated by ParseXML(). It returns false, if at least one of the Validate() method  return false 

 int simulate(): is the most important method of the Simulator class. It sorts the instantiated 

objects of Model class according to their order in the workflow and starts the simulation 

progress as a loop. Each iteration consists of the following steps: 

a.  Checking if the inputProvider objects in the simulation workflow have any Parameters 

in their stacks and transferring the Parameter objects into the Model objects, which 

are connected to the output pin of that inputProvider object    

b. Calling the exec() method of Model objects by invoking runModel() method 

sequentially  

c. Releasing the used resources by Model and InputProvider objects 

Note that, if the number of threads is greater than 1 (specified by the NumberOfThreads 

attribute), the tgroup object from boost::thread group class will be used to make a group of 

threads, assign the runModell() method to them and run the threads simultaneously. 

 void orderModelChain(): arranges the order of the simulation workflow by assigning a number 

to each object of the simulation (Model, InputProvider and ResultConverter objects). The 

simulate() method uses these numbers to find the sequence of the objects in the simulation 

workflow and performs the simulation according to the order defined in the XML file. The user 

specifies the order of the simulation workflow by arranging the ReSUS simulation items and 

making Connection items between them. The Simulator utilizes the following rule to recognize 

the order of the objects of simulation items which reside in memory. It uses the IOProivderType 

enumeration to recognize the InputProvider objects which possesses a Connection on their 

input and/or their output pins. The InputProvider objects which have only connections on their 

output pins, will be determined as possible starting points for the simulation workflow. Due to 

this feature, the orderModelChain() method invokes the forwardOrder(int order) method of 

these start points (which their type is recognized as input) and set the value of their order by 

0. Invoking the forwardOrder(int order) method on an InputProvider object triggers the 

setOrder(int order) method of the next connected Model object. Calling the setOrder() method 

on a Model object upgrades its Order attribute, only if the given Order value as parameter of 

setOrder() method is bigger than the current Order value of the Model, and invokes the 

forwardOrder(int order) method on the next object of the ResutlConverter class, which is 

connected to the output pins of this Model object. Figure 3 illustrates the described process 

for forwarding and upgrading the Order values in a simulation workflow 
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Figure 3 How the SetOrder method works 

  

1.1.4  Model  

The main role of Model class is to provide an interface for connecting the external executables into the 

ReSUS Platform. For this purpose, the Model class requires some additional information such as 

working directory, executor name, the input/output files and the template file.  This information is 

implemented as attributes of this class and is presented in Table 2. 

Table 2. Attributes of the Model class 

Type std::vector<std::string> 

Name logFileCriticalWords 

Description a list of string values that enables the detection of critical words such as “error”, 

“unsuccessfully” etc. in the log files of the assigned executable to the current instance 

of Model class.  Occurrence of any of such words in a log file is an indicator that the 

simulation has been crashed 

Type bool 

Name logFileCriticalWordsBreakIfHappend 

Description If the value of this attribute is True and one of the aforementioned critical words in 

logFileCriticalWords occurs,the simulation should stop 

Type int 

Name numberOfInputPins 

Description specifies the number of input pins for making connections between InputProvider and 

Model objects 

Type int 

Name numberOfOutputPins 

Description specifies the number of output pins for making connections between Model and 

ResultConverter objects 

Type long 

Name timeOut 
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Description timeout in seconds. If the execution of an external executable takes longer than 

defined values for this attribute, the simulator assumes that the executables have 

been crashed 

Type std::vector<std::string>     

Name inputFileNames 

Description a set of file names, which are used as inputs of the executable  

Type std::vector<OutputPair> 

Name outputFileNames 

Description a set of OutputPair objects for validating the existence of the output files  

Type std::vector<Parameter> 

Name inputParameters 

Description an array for storing the parameter values which are received from InputProvider 

objects 

Type std::map<int,IOProvider*> 

Name inputPinsMap 

Description provides access to the InputProvider objects that are connected to the input pins of 

the current Model object 

Type std::map<std::string,ResultConverter*> 

Name inputPinsMap 

Description provides access the ResultConverter objects that are connected to the output pins of 

the current Model object 

Type std::string  

Name workingDirectory 

Description specifies the full path to the directory which contains the assigned executable  

Type std::string  

Name Executor 

Description specifies the name of the assigned executable to the Model object 

Type std::string  

Name executionParameters 

Description the command line arguments that should be passed as parameter to the assigned 

executable  

Type std::string  

Name logFile 

Description if the assigned executable generates a log file, the full path to the log file will be 

specified by this atttribute 

 

The member methods of Model class are described in the following:  
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 int parse(ptree &pt): reads and transfers the contents of the XML node into the attributes of 

the current instance of the Model. The XML node is passed to this method as its input 

argument. This method utilizes the provided API from boost library to parse the XML nodes 

which are defined as ptree structure 

 bool validate(): checks whether the mandatory attributes for running the assigned executable 

contain valid values (See executor attribute) 

 bool ExecuteAndWait(string, string, long &exitCode ): uses the windows API to execute the 

assigned executable files.  It waits till the executable returns a value or reports a failure. This 

method interrupts the simulation progress if the taken time is longer than defined value for 

timeOut attribute  

 bool checkInputPipe(): iterates through the list of  InputProvider objects, which are connected 

to the input pins of the current Model object and checks if they are not empty. If all of the 

checked InputProviders have some Parameter objects in their stack, the top Parameter of their 

stack will be popped and stored in the inputParameters vector 

 int generateInputFiles(): generates the required input files for assigned executable according 

to its defined template files and stored values in the inputParemters vector. This method 

generates new files for each run of the simulation. (For more information, please refer to 

introducing the working mechanism of the template files in the User handbook of ReSUS 

(Ghofrani & Li, 2016)). It performs the following steps:  

a. loads the content of each template file (stored in templateFiles vector) into a string  

b. replaces the placeholder signs in the string with the values of Parameters, which are 

stored in the inputParameters vector  

c. writes the string content in a text file and saves it with the given name for the input 

file  

 int exec(): invokes the checkInputPipe(), generateInputFile() and executeAndWait() methods 

in the same order as they are listed. Furthermore, this method controls the output files of the 

executable after each run with the help of stored configurations in the outputFileNames 

vector. At the end, the ResultConverter objects, which are connected to the output pins of the 

current Model object, will be activated (for more details please check 1.1.10  ResultConverter) 

 void load_file(std::string& s, std::istream& is): reads the content of the text file, which is given 

as second input argument to this method, and loads it into the given string as its first input 

argument. This method is used by generateInputFiles() method 

1.1.5  Outputpair 

Outputpair class keeps the required configuration for controlling the output files of the assigned 

executable to a Model object. Every object, which is instantiated from Model class, keeps a list of 

Outputpair objects in its outputfileNames attribute. The exec() method of Model class reads the stored 

configuration in these objects and controls the existence of the defined files (which are defined as 

filename attribute in Outputpair) and decides to break the simulation if the output file doesn’t satisfy 

the condition about its minimum size and/or number of lines. Controlling the size/number of lines is 

an additional/optional functionality which makes it possible to recognize the crash or failure in the 

execution of the executable, which are assigned to the Model objects.  

The attributes of the Outputpair class store the required information to control the content of each file 

(listed in Table 3). 

Table 3. Attributes o f the Outputpair class 

Type int 

Name numberOfLines 
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Description minimum number of lines that the file should have 

Type std::strgin 

Name filename 

Description the name of the file which is assigned to the current object of this class which should 

be controlled about number of lines and size 

Type int 

Name MinFileSize 

Description minimum size of the file, which is assigned to the current object of Outputpair class, 

in kilo bytes 

Type bool 

Name breakIfHappend 

Description the value of this switch decides about breaking the simulation if one of the conditions 

is not satisfied (minimum size of the file/number of the lines). This value will be set by 

the user in the simulation XML file. if the value of this attribute is set to True, the 

simulation will be interrupted either the number of lines or the size of the file is less 

than their defined values  

 

1.1.6  Parameter 

This class is the implementation of the input parameters for probabilistic simulations.  The objects of 

Parameter class keep the values of probabilistic parameters. In each run of the simulation, the values 

of parameters will be replaced with their corresponding placeholders in the template files to generate 

new input files. This method is used to generate new input files for assigned executables to the Model 

objects (for more details please refer to 1.1.4   Model). In addition, the objects of Parameter class are 

used to transfer the values between the objects of the ReSUS simulation workflow (InputProvider, 

Model and ResultConvertr). The InputProvider objects use Parameter objects in order to store the input 

values for a Model object. Furthermore, the ResultConverter objects send the converted results to the 

InputProvider objects packed as Parameter objects. The Model objects also can forward their received 

Parameter object from InputProviders to the ResultConverters. 

Table 4. Attriutes of the Paramter Class 

Type std::string 

Name name 

Description specifies the name of the parameter (e.g. parameter1) 

Type std::string 

Name unit 

Description specifies the unit of the probabilistic parameter 

Type std::string 

Name description 
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Description additional descriptions about the defined Parameter which may be needed by other 

users of the ReSUS Platform 

Type std::string 

Name minValue 

Description the lower boundary value, which is used by random sample generator to generate 

random values for current Parameter object 

Type std::tring 

Name maxValue 

Description the upper boundary value, which is used by random sample generator to generate 

random values for current Parameter object 

Type std::string  

Name value 

Description stores the assigned values to the current Parameter object 

Type int  

Name Index 

Description specifies the index of the placeholder in template file that should be replaced by the 

value of the current Parameter object 

Type Distribution* 

Name distribution 

Description this attribute specifies the probabilistic distribution type, which is used by random 

sample generator to generate values for the current objects of Parameter class 

Type bool 

Name showInOutput 

Description every ResultConverter object that receives a Parameter object, decides to write it 

down in its binary file according to the value of showInOutput attribute. If the value 

of this attribute is True, the value of the Value attribute of current Parameter object 

will be written in the binary files. The stored values in binary files will be used by 

Analyzer Tool in post-processing operations  

 

1.1.7  Realization 

Realization works as a container class for a set of Parameter objects, which are designated for a single 

run of the probabilistic simulation. This class possesses a vector of Parameter objects, named 

parameters.  

 

1.1.7.1 HDFManager 

HDFManager provides access to the HDF5 formatted files which contain the input values for 

probabilistic parameters of the ReSUS simulations. The implemented methods in HDFManager class 
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help the InputProvider objects to read the content of the HDF5 formatted files and build Parameter 

objects according to the stored values in them.  

Figure 4 illustrates the structure of a HDF5 formatted file as well as the structure of the datasets which 

are stored in it. A dataset is a one dimensional vertical matrix and the values for each simulation 

parameter should be saved in a dataset. The length of the dataset shows the number of Realization 

objects which could be generated from content of a HDF5 file and the number of datasets specifies the 

number of Parameter objects in each Realization object.  

 

Figure 4. Structure of a HDF5 formatted file 

This class implements the following methods: 

 extern "C" herr_t file_info(hid_t loc_id, const char *name, const H5L_info_t *linfo, void 

*opdata):  will be assigned to the H5Literate() method in the body of InputProvider:: 

getRealization() method. H5Literate() iterates through the names of the datasets in the HDF5 

file and for each iteration this method will be invoked. Currernt method of file_inf() stores the 

retrieved name in a vector, called GroupNames. For more information, please refer to the 

manual of HDF5 (HDF Group, 2015) 

1.1.8  InputProvider 

During the simulation, this class is responsible for feeding the Model objects with the values for 

probabilistic parameters. InputProvider objects read the values from HDF5 formatted files with the 

help of the provided methods in HDFManager. Furthermore, the InputProvider objects convert the 

retrieved values form HDF5 formatted files into Parameter objects and store them in a stack.  A Model 

object which is connected to an InputProvider object can check the Parameters in this stack and pop a 

Parameter object as well.  The attributes of the InputProvider are described in Table 5. 

Table 5. Attributes of InputProvider class 

Type int 

Name Id 

Description an integer value for identifying and distinguishing the objects in the simulation 

workflow  

Type std::string 
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Name description 

Description the user can insert additional information or comments about the InputProvider 

object while designing the simulation workflows. This attribute keeps this textual 

information about the current InputProvider object. 

Type std::vector<std::string> 

Name Paramteresfilename 

Description since more than one input file can be assigned to the instances of Input Provider class, 

each string in this attribute specifies a path to a HDF5 formatted file 

Type long 

Name currentRealizationNr 

Description keeps a long integer value as index for retrieving the next realization from HDF5 

formatted file, which will be used by readNextRealizationFromSampleFile() method.  

Type std::string 

Name logfileName 

Description keeps a string value as full path to a text file. This file should store the logs of the push 

and pop operations, which are performed on the stack of the Parameter objects 

Type std::vector<Realization> 

Name Realizations 

Description works as a stack for keeping Realization objects in the memory which are retrieved 

from HDF5 files. In addition, the delivered Parameters objects from Result Converter 

objects, which are connected to the Input pins of the InputProvider object, will be 

converted into a Realization object and pushed in this stack. The pushed values into 

this stack will be popped by Model objects which are connected to the output pins 

(Target) of the current object  

Type IOProviderType 

Name Type 

Description specifies the type of the current object. For more information, please check the 1.1.9 

IOProviderType  

Type Model* 

Name Target 

Description it is a pointer to the Model object, which is connected to the output pin of the current 

object 

Type std::string 

Name Index 

Description in some cases, an object of Parameter class is delivered to an object of the 

InputProvider class, and the delivered object doesn’t have a certain value in its Index 

attribute. For such case, the value of current attribute will be set as index attribute of 

the delivered Parameter object. For more information about transferring Parameter 

objects within the simulation workflow, please refer to User Handbook of ReSUS 
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The important methods of the InputProvider class are explained below: 

1. bool push(const Realization &t): inserts the Realization object , which is given as argument, 

onto the top of the realizations vector 

 bool push(const Parameter &t): works in the same way as the push(const Realization &t) 

method. The only difference is that in this method, before pushing the given Parameter object 

onto the realizations vector, the object will be transformed into a Realization object 

 bool pop(Realization &t): pops the top element of the vector for Realization objects, and puts 

the popped element in the Realization object, which is given as argument to this method. This 

method will be invoked by the Model object in each run of the simulation. It reads the 

Parameter objects from the InputProvider objects which are connected to the input pins of the 

Model object 

 void forwardOrder(int order): forwards the integer value, which is passed to this method as 

input argument, to the next Model object, which is connected to the output pin of the current  

InputProvider object. The connected Models to the output pins of the inputProvider objects 

are accessible via their target attribute 

 bool readNextRealizationFromSampleFile(): invokes  the getRealization() method of the 

HDFManager class to retrieve the values of next realization from HDF5 formatted file. once the 

values are retrieved, this method packs them within a Realization object and increments the 

value of the currentRealizationNr attribute by one  

 std::vector<Parameter> getRealization(long realizationNr,string fileName): loads the values 

of a certain realization from the given HDF5 file and converts them to a vector of Parameter 

objects, and finally returns them. The first argument, long realizationNr, specifies where to 

fetch the values from the datasets. The index number of the values in each dataset specifies 

their realization number. For example, if the value of the realizationNr is 5, it retrieves the 

values in 5th index of each dataset in the HDF5 formatted file. Note that index values are 0-

based. The fileName argument of this method addresses the full path to the HDF5 formatted 

file which should be accessed by this method 

1.1.9  IOProviderType 

This enumeration is declared to let the Simulator recognize the place of the InputProvider objects in 

the simulation workflow. This enumeration represents the type of an InputProvider object according 

to the assigned objects into the input/output pins of that InputputProvider object. The enumerator 

values of this enumeration are described in Table 6. 

Table 6. Member items of the IOProviderType enum 

Enumerator Description 

none=0 considered as Default value for each InputProvider object. This enumerator specifies 

that no other objects are connected to the current InputProvider object 

Input=1 used for marking the InputProvider objects, which has a Model object connected to 

their output pin. It means, that the target attribute of the InputProvider refers to a 

Model object. The InputProvider objects, which their type is set to this value (input), 

are in most cases the starting point in the simulation workflow 

output=2 this enumerator will be set for the InputProvider objects, which their input pins are 

already used and their output pin (target) doesn’t refer to any Model object in 
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following. Due to the fact that a simulation workflow should be ended to a 

ResultConverter object, this type of InputProivder objects are theoretically not valid  

both=3 this enumerator will be set as IOProviderType for the InputProvider objects, which 

their input and output pins are connected to other objects in the simulation workflow. 

This type of InputProvider objects are used to transfer the simulation values between 

the Model objects of a simulation workflow  

 

 

1.1.10  ResultConverter 

This class is responsible for retrieval, conversion and storage of the result values of the simulations. 

The output of the assigned executable to a Model object are in most cases a text file. The 

ResultConverter objects process the content of the text files and retrieve the required information from 

them according to the configurations provided by the user through designing the simulation workflow. 

The user should declare the structure of the text file and specify the required segments of the text file.  

These configurations consist of Regular Expressions which define the pattern of each line of the text 

file as well as a separator pattern which is used for splitting the recognized text lines into some columns. 

The user can select which columns are interesting for post-processing operations. The values of 

selected columns will be stored within binary files for post-processing operations. The content of the 

attributes of the ConvertIndex class specify which columns should be retrieved and stored. For more 

information about ResultConverter, please refer to the User Handbook of ReSUS (Ghofrani & Li, 2016). 

The significant attributes of ResultConverter class are described in Table 7.  

Table 7. Attributes of the ResultConverter class 

Type IOProvider* 

Name target 

Description Is a pointer to the InputProvider, which is connected as next item to the current 

ResultConverter object in the simulation workflow 

Type std::vector<Parameter>  

Name inputParams 

Description is a vector which keeps a list of Parameter objects. These objects are forwarded from 

the connected Model object to the input pins of current object. The contents of these 

Parameter objects will be stored within the binary files for post-processing operations 

Type std::map<int,ConvertIndex>  

Name indexes 

Description every ConvertIndex has an index which links it to a column of the text file. This column 

should be retrieved, converted and stored in the binary files. In most cases, there is 

no need to retrieve the values of each column from a text file. Therefore, this map 

object specifies the only columns which are marked by the user. The value of the key 

in this map is the same value as the index attribute of a ConvertIndex objects which is 

stored in that map 

 

The methods of this class are explained below: 
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1. map<int,vector<double> > extractColumns(string columnFormat, string columnDelimiter, 

map<int,ConvertIndex>  selectedColumnsIndexes ): recognizes and retrieves the columns 

from the text file according to the given specification as input arguments of this method. The 

first argument, string columnFormat, specifies the pattern of the text lines. The value of the 

second argument, string columnDelimiter, is used to split the text line into columns. The listed 

objects in the third argument, map<int,ConvertIndex>  selectedColumnsIndexes, specify the 

required columns that should be stored for the post-processing operations. The selected 

columns and their indices will be stored in a map of vector<double> and returned. In this map, 

the columns are accessible via their index values. The contents of this map object will be 

written in a binary file and can be forwarded to the next level of the simulation workflow 

2. void load_file(std::string& s, std::istream& is): loads the contents of a text file into a string 

variable. The full path to the text file will be passed to this method as a std::istream& object. 

The string object, in which the content of the text should be loaded, will be passed to this 

method as a std::string& object (call by reference). After loading the content of the text file 

into the string object, the string object will be used by extractColumns() method 

3. bool activate(vector<Parameter> inputparameters, int modelId, int rund): works as a trigger 

for activating the ResultConverter object. This method will be invoked by the exec() method of 

the Model object, which is connected to the current ResultConverter object. The Model object 

invokes this method after successful execution of its assigned executable. The first argument 

of current method contains the simulation input parameters, which will be used in post-

processing operations. This method invokes the Convert() method and forwards the input 

parameters of the simulation to it. The Convert() method will store them in the ResultTree 

beside the simulation output values. For more information about ResultTree please check 

1.1.12 ResultTree 

4. std::string convert(vector<Parameter> inputparameters): invokes the extractColumns() 

method and stores the returned values from this method beside the values of input parameters 

within the ResultTree object. In addition, it extracts the parameters which should be forwarded 

to the next layer of the simulation workflow and multiplies their values with their 

corresponding coefficient values which are specified by indexes attribute  

5. void forwardOrder(int order): forwards the given value as its argument, int order, to the next 

InputProvider object which is connected to the current ResultConverter object in the 

simulation workflow 

6. bool validate(): checks all the mandatory fields to start the simulation(regular expressions, 

indexes, input and output file) and returns True. In the case of missing required fields and 

values, this method returns False 

1.1.11  ConvertIndex 

This class implements the required information for extracting the values from the text files. These 

values are usually structured as lines of text, in which the columns are separated by spaces or tabs. The 

ConvertIndex objects contains the information about each column that should be kept for post-

processing operations.  This information consists of a string as a labeled and a value as coefficient. The 

value of the coefficient will be multiplied with each value in the column which are specified by a 

ConvertIndex object. The order of the column in the text file is used as an index for its corresponding 

ConvertIndex object. For more information about ConvertIndex objects, please refer to the 

introduction of Result Converter items in the User Handbook of the ReSUS Platform (Ghofrani & Li, 

2016). 
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1.1.12  ResultTree 

This class manages the reading and writing the simulation results by ResultConverter class from the 

binary file into the memory and vice versa. It provides quick access to the simulation parameters, which 

will be later used to visualize the simulation results as charts or tables. The Id values of the input and 

output parameters of the simulations are used as key for indexing and accessing the realization values 

within the binary files.  

 

 

Figure 5. The structure of a resultTree which is used to  store the simulation results within binary files 

 

In this tree, the negative id values are utilized to differentiate the input parameters from output 

parameters. Since the output values are in most cases in the form of a time dependent array, a two-

dimensional array is required to store them. In such two-dimensional array, the first dimension shows 

the number of probabilistic simulation runs (its length is equal to the sample size) and the second 

dimension stores the values for each run of simulation, which can be more than a single value for the 

case of the time dependent results. Figure 5 illustrates the aforementioned structure for ResutlTree. In 

Figure 5, one can see that the input parameters are addressed by negative id values in the indexes 

table. Furthermore, the addressed values as R1,R2,…RN for the input values are stored in one 

dimensional arrays. Each cell in this array contains the value for the corresponding input parameter in 

a certain realization (each realization corresponding a single run of the simulation). The index of the 

realization is the same value as the index of R in the one-dimension array. In addition, Figure 5 depicts 

that the output values are referred to positive id values in the indexes table. The time dependent 

output values are stored in tow-dimensional arrays so, that the values for the R1,1 and R1,2 specify the 

first and second output values for the Realization R1.  
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Analyzer Tools of ReSUS uses the objects of the ResultTree class to get a fast and direct access to the 

values of parameters for post-processing operations. Table 8 shows the description of the member 

attributes of this class. 

Table 8. Attributes of the ResultTree class 

Type std::map <int, std::vector< std::vector<double> > > 

Name valuesTree 

Description stores the two-dimensional array for each parameter. The key values of the map are 

the id values for the parameters that are stored by this map object 

Type std::map <int, std::string> 

Name namesIndex 

Description provides access to the names of parameters via their index values 

Type std::map <int, std::string> 

Name unitsIndex 

Description provides access to the defined units of parameters via their index values 

Type std::string   

Name Filename 

Description the full path to the binary file, in which the valuesTree object should be saved, and 

also loaded from 

 

 

This class has following member methods:  

 int readTree(): reads the binary file, which is addressed by fileName attribute, and loads its 

content into the valuesTree object. For more details please read the description of the 

writeTree() method  

  int addToTree(int id,string name, string unit,vector<double> values): inserts the given name, 

unit and vector of double values into the valuesTree. The value of the id argument specifies the 

key value for storing and retrieving the values from valuesTreev map  

 int writeTree(): writes the content of the valuesTree into a binary file. The full path to the binary 

file is specified by fileName attribute. This process starts with writing the length of the keys of 

the resultTree map (id of the parameters). For each key of the resultTree map, the value of the 

key (i.e. id of each parameter), the name and the unit string will be written in the file. The 

length of the name and unit are supposed as 200 which is specified by the constant 

StringLength. The assigned values to each key of the resultTree map will be written afterwards 

by two nested inner loops. The first inner loop writes the length of each vector<double> and 

the second writes the contents of that vector. Since the length of each array or vector will be 

written before its values, accessing the related values of each index (id of the simulation 

Parameter values) is faster. Using this progress for writing values into the binary file makes it 

possible to retrieve all related values for a simulation parameter with only one call of freed() 

method in C language. The generated binary files will be used by Analyzer Tool     
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1.2 Graphical User Interface (GUI) 
The Graphical User Interface of ReSUS is developed as a Plug-in for Eclipse (Clayberg, 2008). It is based 

on the Logic Example project from GEF (Graphical Editing Framework) (Rubel, 2011).  

1.2.1  ReSUS Plugin 

In this part, the structure and packages of Graphical User Interface of ReSUS will be introduced. 

1.2.1.1 Plug-in Development Environment (PDE) 

The Graphical User Interface of the ReSUS Platform is implemented as Eclipse Plugin. One should have 

the knowledge about the Eclipse Plugins and Graphical Editing Framework to understand the 

architecture of the ReSUS Platform and particularly the Graphical User Interface of ReSUS. 

The Eclipse platform is known to be a fast and reliable common IDE (Integrated Development 

Environment) for java. Since the industry standard module system for Java (OSGi) allows developers to 

design component based systems with Eclipse RCP (Eclipse Rich Client Platform), the Eclipse platform 

can be used as a foundation to create feature-rich stand-alone application for special purposes. Plug-

in Development Environment (PDE) is used to deliver tailor-made solutions for Eclipse IDE. One can 

contribute to the already existing functionalities such as new menu entries, new toolbar entries or 

create a completely new functionality with the help of Eclipse plugins. In addition, one can create a 

completely new environment as Eclipse Plugin (Clayberg, 2008).  

Knowing the following points about PDE is prerequisite for development of Eclipse plugins, especially 

the User Interface of ReSUS.  

 The plugin.xml as a part of any PDE project is an XML file that contains the required information 

for Eclipse to build that plugin. PDE is equipped with a multipage editor named MANIFEST 

Editor, which allows the developers to change the contained configurations in the plugin.xml 

file. This editor provides six tabs (Overview, Dependencies, Runtime, Extensions, Extension 

Points, and Build). Each category of configurations is available in its related tab for reading or 

manipulating 

 The Extensions tab from MANIFEST Editor includes all the extensions, which are used in the 

plugin under the development. Perspectives, Views, Actions, Wizards, and Editors are the 

mostly used extensions in the development of plugins 

 Running a plugin project in Plugin Development Environment (PDE) of Eclipse is very similar to 

running an application in Eclipse. It will be easily done by selecting the run button from the 

toolbar of Eclipse IDE. Note that the related perspective to plugin development Eclipse should 

be already activated in Eclipse 

1.2.2  Setup  

The Plug-in Development Environment (PDE) (Foundation, 2016) is equipped with tools to create, 

develop, test, debug, build and deploy Eclipse plug-ins. This framework is a part of Eclipse SDK and is 

available to be downloaded from the Eclipse project downloads page (http://download.eclipse.org). 

The Graphical User Interface of ReSUS is a PDE project, which can be opened, manipulated and 

extended by Eclipse. The following steps are required to import and open the ReSUS Graphical User 

Interface in Eclipse: 

 Download Eclipse from the download page of Eclipse Project (http://download.eclipse.org) 

 Start Eclipse 

 In Eclipse, open the File menu and click on Import. It will open the Import Wizard dialog  

 In Import wizard dialog, Under General, select Existing Project into Workspace and click Next 
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 Choose root directory and click Browse to locate the directory which contains the source of 

the ReSUS GUI project 

 Under Projects select de.clausthal.tu.ielf.resus 

 Click Finish to start the import progress 

Since the ReSUS GUI project is based on the Graphical Modeling Framework GEF SDK (Rubel, 2011), 

this framework should be installed on Eclipse. The following steps should be followed to check and 

install this framework on Eclipse: 

 On the Eclipse main menu, open Help > Software Updates, which opens the Install window 

(See Figure 6) 

 Select the all available sites from the Work with combo box 

 Expand the Modeling section and select the Graphical Editing Framework GEF SDK 

 Click Next  

 Accept the agreements and click Install 

 

Figure 6. Installing the Graphical Editing Framework GEF SDK 

Once the installation of Graphical Editing Framework GEF SDK is finished, this framework should be 

attached to the dependencies of the GUI project of ReSUS. In order to attach this framework to the GUI 

Project, follow the steps below in Eclipse IDE. Note that the GUI project of ReSUS should be already 

imported and be opened in Eclipse. (See Figure 7) 

 In Project Explorer, expand the META-INF folder by clicking on it 

 Double click on the MANIFEST.MF file will open MANIFEST Editor 

 Click on the Dependencies tab   

 Click on Add button  

 Type org.eclipse.gef in the Select a Plug-in textbox on the Plug-in Selection dialogue to filter 

the list 

 Select org.eclipse.gef from the filtered list  
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 Click Ok 

 

 

Figure 7. Adding GEF SDK to the Dependencies of the Project 

GUI of ReSUS uses some functions of the HDF5 and Apache Common Mathematics libraries, which are 

attached as jar files to the source of the GUI project. Although these files already exist under the lib 

folder in the GUI project, the way of attaching them are declared as following steps:  

 Open GUI project of ReSUS in Eclipse (if it is not loaded already) 

 If there is no lib folder under the de.clausthal.tu.ielf.resus in Project Explorer, create it  

 Open File>Import to open the Import dialog box 

 Select General>File System and click on Next button (See Figure 8) 
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Figure 8. importing new jars into a PDE project 

  

 In the appeared Import Wizard, select the related jar files (HDF5 and Apache Common 

Mathematics) and store them in lib directory under de.clausthal.tu.ielf.resus project (See 

Figure 9) 

 

Figure 9. Adding the jar files to the lib folder of the GUI project 
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Once the jar files are copied into the lib folder under the source project of ReSUS GUI, they should be 

registered into the plugin.xml file. Registering the jar files in the plugin.xml are described in the 

following steps:  

 Double click on MANIFEST.MF or plugin.xml file in Project Explorer to open the Manifest Editor  

 Open the Runtime tab  

 On the down-right corner of the Runtime tab, find the Classpath section 

 Click on Add… button and select the jar files from lib folder in the JAR Selection dialog box 

which is opened (See Figure 10) 

 

Figure 10. Add the jar files into the Classpath of the GUI Project 

 Under Export Packages section, click on Add button (don’t change the tab, it is within the 

Runtime tab) 

 Select the corresponding packages to the imported jar files, and click on Ok button in the 

Exported Packages dialog box (See Figure 11) 
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Figure 11. Registering the required jar libraries in the runtime page of the plugin 

 

 Open the Build tab of the Manifest Editor 

 In the list of Build Binary, check the inserted jar file which are placed under lib folder now (See 

Figure 12) 
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Figure 12. Selecting the inserted jar files in the list for Binary Build 

 Save the changes in the MANIFEST.TM file 

Note that, adding the jar files into the runtime is not enough to make their functions available in the 

code. The jar files must be added to the libraries in Java Build Path in Eclipse as well (See Figure 13). 
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Figure 13. Adding jar files into the Build Configuration 

1.2.3  Extensions 

The menus, Views, Editors and other components, which are used in the Graphical User Interface of 

ReSUS, should be defined as Extensions in the plugin project. Figure 14 depicts an overview of used 

extensions and components in the GUI project of ReSUS. By clicking on each extension point, the 

related details of the selected extension will be shown in the right side of the Extension tab (See Figure 

14). Furthermore, each of the depicted extension in Figure 14 are introduces in the following 

subsections. 
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Figure 14. Extensions are used to customize the Eclipse Plugin 

1.2.3.1 org.eclipse.ui.perspectives 

All the introduced components within the Extensions tab of the project are assigned to a perspective 

in Eclipse. As depicted in Figure 14,  this perspective is defined as ReSUS Model Designer (perspective) 

under the org.eclipse.ui.perspectives.  

1.2.3.2 org.eclipse.ui.perspectiveExtensions 

This category in the Extensions tab, which is depicted in the Figure 15, contains all the assigned Views 

to the ReSUS Model Designer perspective. Furthermore, one can see that the targetID of the 

perspective extension, which is located under the Extension Element Details part, refers to the defined 

perspective in org.eclipse.ui.perspectives (See Figure 14 and Figure 15). Some of the perspective 

extensions in this list are added directly from the Eclipse User Interface (e.g. Console), while others are 

implemented as classes within the current GUI project (e.g. OutputView).  
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Figure 15. Perspective Extensions of ReSUS Model Designer  

The added Views from the Eclipse UI library to the current project are customized so that they provide 

the required functionalities for ReSUS GUI. Once these Views are introduced as perspective extensions, 

the developers can access them and modify their functionalities. The Views are not the only 

components, which are assigned to ReSUS Model Designer perspective. The newResusProjectWizard 

class is also added to the extensions of this perspective. 

Notice: After installing the GUI plugin of ReSUS in Eclipse, in runtime mode, if the user selects the 

ReSUS Model Designer perspective, the added components to the Extensions section will be shown in 

the ReSUS Model Designer perspective. This perspective will be set as default perspective in the final 

package of ReSUS.  

1.2.3.3 RESUS Model Editor 

This component is the graphical editor for the ReSUS Model Designer perspective. This editor is defined 

under org.eclipse.ui.editors in the extensions tab. (See Figure 16). 
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Figure 16. Related Class to the RSUS Model Editor extension 

Clicking on class link in the Extension Element Details of the ReSUS Model Editor (editor) opens the 

linked class to this item. Figure 17 depicts the content of this class which extends the ResusEditor class 

and implements the ITabbedPropertySheetPageContributor interface.  

The main features and functionalities of this editor, e.g. save and load the XML content of models, are 

implemented in the ResusEditor class. For more details, please refer to the documentation of logic 

editor example of GEF (Rubel, 2011). The ReSUSEditor class is based on 

org.eclipse.gef.examples.logicdesigner.LogicEditor.java from the source code of logic editor example.  

Implementing the ITabbedPropertySheetPageContributor allows this graphical editor to show the 

Properties View in the tabbed form.   

 

Figure 17. Content of the Editor Class which enables using tabbed Properties 
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Hint: for more information about tabbedpropertysSheet please refer to the website of Eclipse under 

the following link: 

http://www.eclipse.org/articles/Article-Tabbed-Properties/tabbed_properties_view.html 

 

All the related classes to the tabbed Properties View are packed under the package with the name 

org.eclipse.ui.views.properties.tabbed within the source code of the GUI project of ReSUS. The 

TabbedPropertiesResUsEditor class is the stored under this package too.   

1.2.3.4 Tabbed Properties Contributor 

The tabbed Properties View should be interconnected with a property contributor. The assigned 

properties contributor of the ReSUS Model Editor is defined under the 

org.eclipse.ui.views.properties.tabbed.propertyContributor. This item is located under the Extensions 

of the GUI plug-in. The assigned labelProvider and typeMapper components to this 

propertyContributor item are defined in its Extension Element Details (See Figure 18).  

 

Figure 18. PropertyContributor 

1.2.3.5 Org.eclipse.ui.views.properties.tabbed.propertyTabs 

The tabbed Properties View requires tab component to show the details of graphical components in 

the ReSUS Graphical Editor. Figure 19 depicts that all the PropertyTab items are defined and listed under 

the org.eclipse.ui.views.properties.tabbed.resus.TabbedPropertiesRESUSEditor, which is located 

under  org.eclipse.ui.views.properties.tabbed.propertyTabs. Note that, the ContributorId of each 

org.eclipse.ui.views.properties.tabbed.resus.TabbedPropertiesRESUSEditor item should be identically 

equal to the contributorId for PropertyContributor item which is assigned to that item. (See 1.2.3.4 

.Tabbed Properties Contributor). Furthermore, the items under the   item specify the name, id and 

order of the tabs. Figure 19 depicts an example of tab ordering. 



33 

 

 

Figure 19. List and details of the defined tabs for tabbed Properties View 

1.2.3.6 org.eclipse.ui.views.properties.tabbed.propertySections 

This item is responsible for defining extensions for the tabs which are introduced under 

org.eclipse.ui.views.properties.tabbed.propertyTabs. Each tab can possess one or more sections. The 

details of each defined propertySection element is described in Table 9. Note that, the * character 

beside the name of some fields is used to show the filed as mandatory.  

Table 9. Attributes of the org.eclipse.ui.views.properties.tabbed.propertyTabs class 

Name tab* 

Description The id of the tab item that possesses the current propertySection element  

Name id* 

Description is a unique string value for identifying the current propertySection element  

Type class* 

Description specifies the package name and the class name of the class which is linked to the 

current section. This class implements the visual components, e.g. button, label and 

textbox, which should be shown on this propertySection element 

 

For example, Figure 20 depicts the details of the InputProviderConfigurationSection item. One can see 

that this section belongs to a tab which is identified by resus.tab.inputProvider.configurations. 

Furthermore, this section possesses an id with the value of resus.section.inputProvider.configurations, 

and a class with the following specifications is responsible for implementing this section : 

org.eclipse.ui.views.properties.tabbed.resus.properties.InputProvider.InputProviderConfigSection 
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Figure 20. Property Section of the tabbed Properties 

As mentioned in User Handbook of ReSUS (Ghofrani & Li, 2016), the user utilizes the tabbed Properties 

View to edit the configuration of the graphical components of ReSUS (InputProvider, Model and 

ResultConverter). The related classes to each of these graphical components are categorized and stored 

under a package in the source code of GUI project of Resus. These packages are accessible under the 

org.eclipse.ui.views.properties.tabbed.resus.properties package name. For example, the classes 

related to the tab sections of Model item are categorized and stored under the following package 

name:  

org.eclipse.ui.views.properties.tabbed.resus.properties.Model 

The same format is used for storing the related sections to the InputProvider:  

org.eclipse.ui.views.properties.tabbed.resus.properties.InputProvider  

1.2.3.6.1 general information about linked classes to the 

propertySections items 

As mentioned in 1.2.3.6 each propertySection element is connected to a class which contains the 

implementation of that propertySection element. These classes have same structure but differ in the 

implementation of their methods. The general structure of these classes are described in this 

subsection.  

The AbstractSection class contains the general structure of the classes which should implement a 

propertySection element of a tab. Therefore, all of the related classes to the propertySection elements 

should extend this abstract class. This class is located under the 

org.eclipse.ui.views.properties.tabbed.resus.properties package in the source code of the GUI project 

of ReSUS. Furthermore, this class extends AbstractPropertySection class and implements 

PropertyChangeListener. This interface enables the AbstractSection class to receive the events which 

occurs on the graphical components or tabs by user. These events occur if the user perform changes 

on the values of graphical components in a simulation workflow.  

The significant attribute of this class is introduced in Table 10.  

Table 10. Significant attribute of the AbstractSection 

Type ResusElement 
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Name Element 

Description provides a reference to the related class of the graphical component which is 

presented via current tab. The defined get() method of current class provides the 

accessibility to this reference for other classes, in particular the children of this class, 

for setting and updating the shown values on the tab section 

 

The member methods of this class are described below:  

1. public void setInput(IWorkbenchPart, ISelection): validates the selected item on the Resus 

Model Editor. The selected Item should be one of the three graphical components which are 

provided by ReSUS Model Designer to design a simulation workflow (InputProivder, Model 

Frame or ResultConverter) 

2. public void aboutToBeShown(): please refer to documentation of Eclipse (Clayberg, 2008) 

3. public void aboutToBeHidden(): please refer to the documentation of Eclipse (Clayberg, 2008) 

4. public ResusElement getElement(): returns the reference to the model class of the graphical 

component, which its properties are shown via the current tab section 

5. public void propertyChange(PropertyChangeEvent): invokes the refresh() method of the 

current object to update the information that is shown by the current propertySection. Every 

child class which extends the AbstractSection shows only the related information that is 

assigned to it as an Element object. Therefore, the refresh() method is overridden by child 

classes to show their corresponding configurations (for more information please refer to 

refresh() method in the next section)  

6. public void runCommand(SectionCommand cmd): inserts the given command object into the 

command stack of the ReSUS Model Editor  

 

1.2.3.7 org.eclipse.ui.views.properties.tabbed.resus.properties.Model 

This part provides a description about the general structure of the classes under the 

org.eclipse.ui.views.properties.tabbed.resus.properties.Model package. Every class under this 

package should extend AbstractSection class (See Figure 21). The general structure of these classes 

consists of some text fields. Each text field is assigned to an object of TextHelpChangehelper class which 

observe the inserted changes by the user on these text field controls (Depicted in Figure 21).   
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Figure 21. Example of the structure for tab section classes 

1.2.3.7.1 CreateControls() method 

The defined text fields and other controls (e.g. buttons, labels and tables) for each propertySection 

should be instantiated and configured within the body of CreateControls() method. Thereafter, they 

should be assigned to the composite object, which is given to the createControl() method as the input 

parameter.  

 

Figure 22. The example code snippet for body of the createControls() method 

Figure 22 depicts the instantiation of text txtLogFilename object and its configuration steps. 

Additionally, it shows that the click listener objects are added to the Button objects within this method 

direct after instantiating them.  
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1.2.3.7.2 refresh() method 

This method loads rows of the tables and the related values to the selected graphical components (e.g. 

Model Frame) from the resusElement object, which assigned to the current section, and set as the text 

values of the controls on the section (e.g. the numberOfInputs value from ResusModel object into its 

related textbox). Before setting the values within controls by the refresh() method, the change listener 

objects should be disabled. After setting the values in their controls, they should be enabled again (See 

Figure 23).  In order reassure that the change listener objects will be reactivated after setting the values 

into the controls by refresh() method,  this steps are wrapped within a try and finally block.  

 

Figure 23. An example of refresh() method in tab section 

Hint: there are some sections, in which a table view should show some values. Setting and reloading 

the values within a table is a little bit different. In addition to refreshing the data columns of a table, 

the assigned buttons to each row should also be disposed and generated again.  

 

Figure 24. The body of refresh() method for tab sections which contain TableViewer objects 

The progress of binding data and assigning buttons to the table, which are implemented within 

createControls() method, are introduced below. The values of the tables will be reloaded every time 

that the refresh() method is invoked (See Figure 24). 
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1.2.3.7.3 Handling tables in tab sections 

TableViewer objects are used to show a list of values on the linked classes to the propertySection items. 

The general structure of the TableViewer objects are defined in the body of createControls() method. 

The Table objects are generated by getTable() method of TableViewer class. and are configured like 

other controls within the createControls() method.  Figure 25 depicts a sample code from the 

ModelOutputFiles class. In this class the list of assigned output files to the model frame should be 

shown within a TableViewer object.   

 

Figure 25. Initializing the TableView objects for tab sections 

In order to show some data within a TableViewer, there is a need of data models. The data models are 

the classes, which contains the corresponding fields of columns that should be shown by a Table object. 

The objects of these data model classes should be stored as an ArrayList object and passed to the 

TabelViewer instances with the help of setInput() method (for more information please see the details 

of the TableViewer class in the documentation of Eclipse (Eclipse, 2016)). The corresponding values to 

each cell are defined in separate fields within the data model objects. Figure 26 depicts an example of 

the OutputPair class, which is used as model class to show the list of information about output files of 

the ModelFrame objects. 

 

Figure 26. The content of the data model which shows a list of output file of a Model Frame 
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The TableColumn class is responsible for defining the columns of each instance of Table class. For each 

column in a table, a new object of TableColumn should be instantiated, configured and added to that 

object of table class. Figure 27 depicts the corresponding code snippet for generating a column for 

showing the row numbers in the tables, which automatically fill the rows with row numbers.  

 

Figure 27. Adding counter Row in order to give the number to each row in the TableViewer in tab sections 

The new instance of the ColumnLabelProvider class is responsible for retrieving the data from the data 

model and showing it within each row (depicted in Figure 28). It reads the values from the data model 

object which is assigned to the current TableViewer object. As illustrated in Figure 28, the getText() 

method of the ColumnLabelProvider() class is overridden to  provide  this functionality. Furthermore, 

Figure 28it depicts how the new instantiated object of the class ColumnlabelProvider is added to the 

firstNameCol object.  The firstNameCol object is an instance of TableColumn class and provides a 

column for showing values of the fileName attribute from the OutputPair objects within the Table 

object of the TableViewer instance. 

 

Figure 28. Adding the ColumnLabelProvider object to the columns 

 

The Buttons controls which are added to the TableViewer within Refresh() method (See 1.2.3.7.2), are 

configured within the createControls() method. In createControls() method, after adding each 

ColumnsLabelProvider object to the Column objects, which contains the Button controls, their update() 

method is overridden. The update() method checks if the corresponding element of the current table 

cell is already in the list of bound Button objects. If not, it generates a new Button object, configures 

and adds it to the current row of the Table object of the TableVeiwer instance (See Figure 29).  
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Figure 29. Adding the buttons to the Table Columns 

Figure 30 depicts the instantiation and configuration of the event listener for the Button controls within 

the update() method. It also illustrates a snippet of code in which an action listener is defined for an 

object of Button class. The illustrated part of code by Figure 30 is collapsed in the Figure 29. 

 

Figure 30. Defined Action Listener object for the remove buttons in the TableViewer 

 

1.2.3.8 Performing Undo and Redo commands 

The Graphical Model Editor of ReSUS uses the MVC design pattern, in which the changes on values in 

model will be done via a stack of Command objects. It means, for every operation in the Graphical User 

Interface there should be a class which extends the org.eclipse.gef.commands.Command. These 

classes are stored under the de.clausthal.tu.ielf.resusdesigner.model.commands package. In addition, 

the command classes for each graphical component of ReSUS Model Designer is stored under a sub 

package with the name of that item. For example, the related classes to the ResusModel are stored 

under the de.clausthal.tu.ielf.resusdesigner.model.commands.ResusModel. In a similar way, the 

command classes for InputProvider are stored under 

de.clausthal.tu.ielf.resusdesigner.model.commands.InputProvider.  
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1.2.3.8.1 SectionCommand 

The SectionCommand class is the parent of all command classes in GUI project of ReSUS and extends 

the Command class (See1.2.3.8.2). The SectionCommand class handles the change actions on the 

properties of graphical components of ReSUS (e.g. Model Frame). The main functionality of this class 

is implemented by its member method setPropertySection(). This method connects the 

propertySection objects to their related command.  

1.2.3.8.2 General structure of Command class 

The general format of the classes, which extend the SectionCommand class, is introduced in this 

section. The classes that extend the Command class, are in most cases designated for updating some 

values. Therefore, they have member attributes for keeping the new values which should be replaced 

by the old ones. In addition, these classes should have a reference to the model object of the graphical 

component which the updates should be performed on. Figure 31 illustrates an example of such 

classes, in which two String objects are designated for keeping the old and new Id values for an instance 

of InputProvider class. The aforementioned reference to the model item is implemented by the part 

attribute of this class. This attribute provides a reference to the object of InputProvider class and will 

be used to perform the changes on the addressed model item.  

 

Figure 31. Defining member attributes to keep old and new values of a property, which should be changed 

Every class in GUI project of ReSUS which extends the SectionCommand class should implement the 

following methods:  

1. public void execute(): makes a backup of the attribute which should be updated and invokes 

the redo() method  

2. public String getLabel(): returns an string, which will be shown in the toolbar of the ReSUS 

Mode Designer as a tooltip on next and previous buttons 

3. public void redo(): performs the intended updates on the corresponding attribute of the 

assigned model class to the current object. In addition, the propertySection of the item which 

is assigned to this class should be refreshed. It updates the propertySection item and loads the 

latest changed values in its controls 

4. public void set[attribute]: the name of this method is dependent on the name of attribute, 

whose value should be changed. For example, for a command class which updates the Id 

attribute of a model class, the name of this method is setId(). This method gets the value, which 

should be set as a new value and keeps it in the corresponding defined object as a new value 

(e.g. newId) 

5. public void setPart(): sets a reference to the model class in which a property should be changed 

6. public void undo(): this method will be called when the user clicks on the undo button. It sets 

the old value, which is backed up by the execute() method, to the properties of related object 

of model class 

7. public boolean canExecute(): performs the prerequisite conditions, which should get 

examined before any command can be executed. Invalid, empty or out of range values for the 

properties can be controlled here before the execute() method updates any value 
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1.2.3.9 Palette  

The Palette component as a part of Graphical Model Designer of ReSUS is implemented in the GEF 

framework (For more information please refer to the help page of org.eclipse.gef.palette.PaletteRoot). 

An object of the org.eclipse.gef.palette.PaletteRoot class is instantiated and configured within the 

ResusPlugin class. The graphical components for designing the simulation workflows are attached to 

this object by methods of the ResusPlugin class. The ResusPlugin class is located under the 

de.clausthal.tu.ielf.resusdesigner package.   

The most important methods of this class are described below:  

1. static PaletteRoot createPalette() : is the start point for instantiating and customizing the 

object of PaletteRoot class. This method will be invoked by getPaletteRoot() method from 

ResusEditor class 

2. static private List createCategories(PaletteRoot root): generates two categories of items on 

the palette and adds them to the object of PaletteRoot class which is given as argument of this 

method  

3. static private PaletteContainer createControlGroup(PaletteRoot root): creates the marquee-

selection-tool, which makes the user able to select the graphical individually or multi, and adds 

them into the given object of PaletteRoot class as input argument. In addition, this method   

creates the connection item and adds it to the object of PaletteRoot class 

4. static private PaletteContainer createComponentsDrawer(): generates the graphical 

components (Model Frame, InputProvider, ResutlConverter) and adds them into the palette. 

These components will be utilized by ReSUS Model Designer for designing the simulation 

workflows 

 

1.2.3.10 OutputView 

Since the OutputView is an additional view which is not offered by the Eclipse Plugin Framework, the 

important points about this component are introduced here.  

This class reads a list of the ResultConverter items from current simulation workflow model, which is 

open in the ReSUS Model Designer and shows them within a Tree control. This class has two attributes 

that are introduced in Table 11. 

Table 11. Attributes of the OuputView class 

Type org.eclipse.swt.widgets.Tree 

Name Tree 

Description keeps the name of the ResultConverter components as a list of checkbox controls and 

shows them on the OutputView. It allows the user to select or unselect some 

ResultConverter items before starting to visualize the output values of the simulations 

by Analyzer Tool 

Type de.clausthal.tu.ielf.resusdesigner.ResusEditor 

Name resusEditor 

Description specifies a reference to the Graphical Model Editor which is active on the GUI. This 

reference makes it possible to get a list of ResultConverter items which are defined 

within the currently opened simulation workflow model in that Graphical Model 

Editor  
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The OutputView class extends the ViewPart interface from org.eclipse.ui.part package, which provides 

the basic functionalities for Views in Eclipse workspace such as CreatePartControl() and Refresh() 

methods. These methods, which are implemented in OutputView, are introduced below:  

 public void createPartControl(Composite parent): is responsible for creation and initialization 

of the visual components of OutputView class.  First of all, two Button objects, namely 

btnCharts and btnExport are initialized in this method. In addition, it adds the selection listener 

objects to the buttons which define their functionalities. At the end, this method calls 

getResultConvertors(), and populate the Tree object with the list of ReslutConverter objects, 

which are returned by getResultConvertors() method. The created SelectionEvent for btnChats 

control is responsible for reading the list of selected ResultConvertes from the Tree object. It 

creates an XML file according to the input format of the ChartTool of ReSUS and invokes the 

ChartTool. The same functionality is defined for btnExport control to collect the information 

about selected ResultConverter items and send them to the Export Tool as an XML file  

 public void refresh(): will be automatically invoked, each time that the OutputView is activated 

or reselected. It loads the list of ResultConverter items into the Tree object with the values of 

their Name and Id attributes  

 

1.2.4  Source Code packages  

A brief description about each package in the source of the Graphical User Interface is given in this 

part.  

de.clausthal.tu.ielf.randomGenrators: keeps the classes which are implemented for generating 

random sample values (sobol’ and simple random)   

de.clausthal.tu.ielf.randomGenrators.distributions: contains the classes for the modeling of statistical 

distributions, which are used in sample generation operations  

de.clausthal.tu.ielf.resus.views: contains the OutputView class  

de.clausthal.tu.ielf.resus.wizards: contains the related classes to the implemented wizards for 

Graphical User Interface of ReSUS. The classes for each page of each wizard are also kept within this 

package 

de.clausthal.tu.ielf.resusdesigner: contains the related classes to the Graphical Model Editor of the 

ReSUS and its Template Editor. In addition, the text strings for the messages which should be shown by 

objects of these classes are stored in this package under the ResusMessages class and a file with the 

name of messages.properties 

de.clausthal.tu.ielf.resusdesigner.actions: contains the ResusActionBarContributor class 

de.clausthal.tu.ielf.resusdesigner.edit: contains the related classes to the editPart and editPolicy of 

the graphical components (Model Frame, Input Provider and ResultConverter). The classes that are 

kept under this package specify the resize rules for aforementioned graphical components as well as 

the connection rules between them 

de.clausthal.tu.ielf.resusdesigner.figures: contains the classes which, specify the figures and drawing 

form of the graphical components of the ReSUS Model Designer 

de.clausthal.tu.ielf.resusdesigner.icons: contains the image files for icons that are used for the 

graphical components of the ReSUS Model Designer  
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de.clausthal.tu.ielf.resusdesigner.model: Contains the model files for the graphical components of the 

ReSUS Model Designer 

de.clausthal.tu.ielf.resusdesigner.model.commands: contains the general classes that are used to 

implement redo and undo actions 

de.clausthal.tu.ielf.resusdesigner.model.commands.InputProvider: contains the command classes 

which are specified for changing the values of the InputProvider model objects (input Provider) 

de.clausthal.tu.ielf.resusdesigner.model.commands.ResultConverter: contains the command classes 

which are specified for changing the values of the ResultConverter model objects (Result Converter) 

de.clausthal.tu.ielf.resusdesigner.model.commands.ResusModel: contains the command classes 

which are specified for changing the values of the ResusModel model objects (Model Frame) 

de.clausthal.tu.ielf.resusdesigner.model.icons: contains the images that are used to draw the 

graphical components of the ReSUS Model Designer  

org.eclipse.ui.views.properties.tabbed.resus: contains the general classes, which are used for 

illustrating the tabs and property sections within Properties View within ReSUS Model Designer 

org.eclipse.ui.views.properties.tabbed.resus.properties: contains the general classes, which are used 

for illustrating the tabs and property sections within Properties View within ReSUS Model Designer 

org.eclipse.ui.views.properties.tabbed.resus.properties.InputProvider: contains the specified classes 

for the sections of the properties View for Input provider that is selected on the Graphical Model 

Designer of ReSUS 

org.eclipse.ui.views.properties.tabbed.resus.properties.Model: contains the specified classes for the 

propertySection items which are related to the ResusModel objects 

org.eclipse.ui.views.properties.tabbed.resus.properties.ResultConverter: contains the specified 

classes for the propertySection items which are related to the ResultConverter objects 

resus.hanlders: contains the classes that implement the assigned commands for running the 

simulation in single or parallel mode 

resusPerspective: contains the related classes to the ReSUS perspective in the Eclipse workbench 

  

1.2.5  Wizards 

The New ReSUS Project and New Sample Wizard items help the user to create a new project or new 

sample of random values.  Figure 32 depicts that these items are already registered as Extension Points 

within the MANIFEST. The related classes to the both of these wizards are stored under the 

de.clausthal.tu.ielf.resus.wizards package.  Note that these wizard items are developed based on JFace 

toolkit (Eclipse, 2016). For more information about wizards in eclipse plugins please refer to the Eclipse 

website. An overview of these wizards and their pages is introduced in the following parts.   
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Figure 32. Registered Wizards in Extension points of the GUI Plugin 

1.2.5.1 NewResusProjectWizard 

This class is responsible for showing the designated pages within New Project Wizard. This class extends 

org.eclipse.jface.wizard.Wizard class and implements the org.eclipse.ui.INewWizard interface. The 

attributes of current class are introduced in Table 12.  

Table 12. Attrbutes of the NewResusProjectWizard class 

Type de.clausthal.tu.ielf.resus.wizards.NewResusProjectPageOneWizard 

Name pageone 

Description specifies a reference to a class that implements the controls and behavior of the first 

page of this wizard (See 1.2.5.1.1) 

Type de.clausthal.tu.ielf.resus.wizards.NewResusProjectPageTwoWizard 

Name Pagetwo 

Description specifies a reference to a class that implements the controls and behavior of the last 

page of this wizard 

 

The important methods of NewRessuProjectWizard are introduced below:  

 public void addPages(): is overridden to initialize and add the wizard page objects into this 

wizard class  
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 public boolean performFinish(): will be invoked after the user clicks on the finish button on 

this wizard. This method is responsible for generating new folder and copy a new XML file into 

it according to the submitted information through the pageone and pagetwo objects  

1.2.5.1.1 NewResusProjectPageOneWizard 

This class is responsible for generating the first page of New Project Wizard. There are some controls 

placed on this page for gathering a path and a file name. This information will be used by 

NewResusProjectWizard class to generate a folder and a file for a new project. Note that the page 

classes should extend the org.eclipse.jface.wizard.WizardPage class.  

The attributes of this class are the simple controls (e.g. textbox and labels) that are initialized with their 

proper values within the createControl() method of this class. There are also two getter methods 

available to provide the access to the designated variables for project name and address for 

NewResusProjectWizard class.   

1.2.5.2 NewSampleWizard 

This class extends the org.eclipse.jface.wizard and implements the INewWizard interface. It is located 

under the de.clausthal.tu.ielf.resus.wizards package in source code of GUI project of ReSUS. This wizard 

helps the user to generate and store the random sample values for the input parameters of probabilistic 

simulations. The NewSampleWizard implements these functionalities as three steps within three 

wizard page items. The corresponding classes for these pages, which are located in the same package. 

The corresponding references to objects of these classes are defined as attributes of 

NewSampleWizard class. These attributes are described in Table 13.  

Table 13. Attributes of NewSampleWizard class 

Type de.clausthal.tu.ielf.resus.wizards. NewSamplePageOneWizard 

Name pageOne 

Description specifies a reference to a class that implements the controls and behavior of the first 

page of this wizard (See 1.2.5.2.2) 

Type de.clausthal.tu.ielf.resus.wizards. NewSamplePageTwoWizard 

Name pageTwo 

Description specifies a reference to a class that implements the controls and behavior of the 

second page of this wizard (See 1.2.5.2.3) 

Type de.clausthal.tu.ielf.resus.wizards. NewSamplePageThreeWizard 

Name pageThree 

Description specifies a reference to a class that implements the controls and behavior of the third 

page of this wizard (See 1.2.5.2.4) 

Type Java.lang.String 

Name filename 

Description specifies the full address to the HDF5 file that is designated to keep the generated 

sample values  

Type ArrayList<Parameter> 

Name parameterConfigurations 
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Description is a list of Parameter objects which contain the configurations for generating random 

values 

 

This class possesses an important method:  

1. public void addPages(): is overridden to instantiate and initialize the designated attributes for 

the wizard pages  

1.2.5.2.1 Parameter 

The instances of this class are to keep and present the configurations for input values, which should be 

randomly sampled. This class implements the Serializable interface that makes it possible to write the 

objects of this class directly into the binary files.  

1.2.5.2.2 NewSamplePageOneWizard 

This class is responsible to show a wizard page, therefore it is obliged to extend the 

org.eclipse.jface.wizard.WizardPage class. It contains the visual components for creating, removing 

and editing the Parameter objects. In addition, this page provides the functionalities to save and load 

the list of the Parameter objects. The prominent method of this class is introduced below:  

1. public void createControl(Composite parent): this method instantiates and initializes the 

controls (visual components of JFace toolkit, e.g. labels and textboxes). It also defines the 

action listener for the Button objects which are added to this page. In the first part of this 

method, a keyListener object is defined for the corresponding textbox for template name. This 

keyListener object examines if some text is inserted into this checkbox. If this textbox is filled 

by the user, the KeyListner object enables the Next button on this page. The table of the 

parameters is initialized as next in the body of the createControl() method.  The Parameter 

class is used as the data model in background of this table. For every field of the Parameter 

class, a table column is defined. Only the details of the Distribution class are not designated in 

this table. Figure 33 depicts the initialization of the edit column.  

 

Figure 33. Initialization of the edit column in the table of parameter configurations 

Figure 34 depicts the assigning of the Edit buttons to their rows in the table. The editButtons object is 

an instance of Map class which binds the designated Button objects to their Cells in the table. 

Instantiating the Button objects for removing the Parameter objects from the table is implemented in 

the same way.  
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Figure 34. Binding each row to its corresponding Edit button within the label provider object 

An object of de.clausthal.tu.ielf.resus.wizards.ParameterEditDialog enables the user to edit the 

values of Parameter objects. Figure 35 depicts that this object is instantiated and shown within the 

defined action listener for the designated Button objects as Edit button.  
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Figure 35. Initializing the Edit dialog for the Parameter objects 

The object btnSaveAsTemplate, which is an instance of Button class, is initialized and assigned to wizard 

page. This Button object facilitates saving the objects of the Parameter class in a binary file. The defined 

action listener for this button object implements some validation steps to check whether the file exists 

and/or the given path is valid. Once the path is validated, it writes the content of the parameters -

which is an object of the ArrayList class- into the given binary file.  

The action listener object that is assigned to the btnLoadTemplate object, loads a list of Parameter 

objects from a binary file into an ArrayList object. This ArrayList object will be used by this method to 

show the values of Parameter objects within a table. This operation is done via following steps:  

1. Loads a dialog box that shows the existing template files in the folder of the simulation project 

and enables the user to select one of them or cancel the operation. This step is done via 

initializing and showing an object of the 

de.clausthal.tu.ielf.resus.wizards.SampleTemplateSelectDialog class 

2. Before loading any new list of Parameter objects into the table, it is necessary to check if any 

changes is made to the current list of Parameter objects. Checking the value of 

isTemplateChanged variable makes it possible to get informed about the status of the current 

list of Parameter objects. If any changes are perceived, which is not already saved, a message 

dialog will ask the user to save or discard the changes before the new values are loaded into 

the table 

3. In the last step, the values from the selected template file will be loaded into the ArrayList of 

Parameter objects. The instance of Table class reads the content of this ArrayList<Parameter> 

object and shows the Parameter objects of it  

Clicking on the btnAddNewParameter object, initializes and views instance of the ParameterNewDialog 

class to the user. This class gathers the information about the new Parameter object, instantiates a new 

object from this class according to the given configuration by the user, and returns it to its invoking 
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method. The defined action listener for btnAddNewParameter object gets the newly inserted 

Parameter object and inserts it into the list of the Parameter objects. Finally, this method invokes the 

refresh() method of the table to make the recently added Parameter object visible.  

 

1.2.5.2.3 NewSamplePageTwoWizard 

This class as a page of the NewSampleWizard extends the org.eclipse.jface.wizard.WizardPage class. 

The main usage of this class is to generate random sample values according to the submitted Parameter 

objects within the NewSamplePageOneWizard object, and to write them into the HDF5 files. (In order 

to get more information about provided functionalities from HDF5 (Hierarchical Data format 5) libraries 

please refer to the website of HDF5 group (HDF Group, 2015)). The main functionalities of this class are 

implemented as two methods which are introduced below:  

1. public void createControl(Composite parent): initializes the controls, which should be shown 

on the current wizard page. The first initialized control is a textbox  which is designated for 

inserting the full path to a file. The next control that is initialized is the browse Button object. 

This button provides a Save File dialog for getting the full path to a HDF5 file, in which the 

randomly generated sample values will be stored. Furthermore, this method initializes the 

btnGenerateSample object and assigns the generateSample() method to it. Clicking on this 

button generates random sample values 

2. private void generateSample(): generates random sample values according to the selected 

random sample generation methods by the user, parameters configurations, and the length of 

the sample that are also submitted by the user. In addition, this method writes the generated 

sample values into a HDF5 file. It writes the values and configuration of each parameter as a 

table (dataset) into the HDF5 file. The configurations of each parameter object will be written 

as Attribute values of the specified table to that parameter. For more information about HDF5 

please refer to the website of HDF5 group and the java sample codes for storing values and 

attributes (HDF Group, 2015) 

1.2.5.2.4 NewSamplePageThreeWizard 

This class realizes the third page as well as the final step of NewSampleWizard. It extends the 

org.eclipse.jface.wizard.WizardPage class and overrides the createControl() to add the designated 

controls. The main functionality of this page is to read the sample values from a HDF5 file and to show 

them as a hierarchical structure in which the realizations are in an upper level to their parameters. This 

method uses the provided API from HDF5 library (HDF Group, 2015).   

In order to show the content of a generated sample file (given HDF5 formatted file), this class creates 

and initializes some control from JFace library. It uses a Tree object to show a list of realizations and a 

TableView object to show the details of each realization that is selected by user in the aforementioned 

Tree control. A brief description about attributes of this class is given in Table 14. 

Table 14. Attributes of the NewSamplePageThreeWizard class 

Type Java.lang.String  

Name fileName 

Description specifies the full path to the HDF5 file which contains the sample values as well as 

parameter configurations 

Type ArrayList<double[] > 
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Name Realizations 

Description is a collection of the sampled input values for a realization. The values of each dataset 

(respectively the values for each simulation parameter, which is loaded from the HDF5 

file, will be kept as a member of this dataset. The double[] array contains the values 

of each realization regarding the current member of the ArrayList object. The index of 

double[] are designated to finding the realization number  

Type ArrayList<Parameter> 

Name Attributes 

Description each dataset in HDF5 file contains the configurations which are used to generate the 

values of that dataset. Since each dataset can represent only one input parameter, the 

configurations of that parameter are stored as Attributes in the same dataset. This 

ArrayList object keeps the list of configurations of datasets that are loaded from HDF5 

file. In addition, it will be used to show the details of each input parameter within the 

TableView object 

 

The functionalities of this class are implemented according to the following descriptions: 

 public void createControl(Composite parent): is responsible for initialization of the TableView 

object which shows the values of input Parameters objects. The TableView object consists of 

six columns, each column of this table shows the content of one field of the parameter object 

(e.g. Name, Unit, Distribution etc.). One of these six columns is also designated to show the 

values of each parameter for the selected realization. The TableView object contains no 

information in its initial state. When the user click on an item within the realizations Tree 

control, the related values to the selected realization will be loaded into the TableView object. 

The refresh() method of current class is responsible for reading the data form HDF5 file and 

loading them into the  

  public void init() throws NullPointerException, HDF5Exception: utilizes the HDF5 API (for 

more information please refer to the website of HDF5 group (HDF Group, 2015)) to open the 

given HDF5 file and retrieve the names and attributes of datasets. The values for each input 

parameter is kept within a dataset in the HDF5 file. In addition, the configurations which are 

used to generate the random sample values for that parameter are stored as attributes of the 

dataset in the HDF5 file 

 public void refresh() throws NullPointerException, HDF5Exception: loads the number of 

realizations from HDF5 file into the Tree object. Invoking the init() method from the current 

class loads the list of existing dataset within HDF5 file and the length of each realization into 

the designated attributes of this class. The refresh() method defines an index for each item in 

the tree through initializing the tree items with the realization numbers. In addition, this 

method defines an action listener for the Tree items. This action listener will invoke the 

fillTable() method and pass the realization index, which is assigned to the current tree item,  to 

this method 

 private void fillTable(int realizationIndex): receives an integer as index of the realization and 

loads the related parameters and their configurations into an ArrayList of Parameter objects. 

In the next step, it sets the ArrayList object as the input of the TableViewer object  

 double[] ReadDatasetLenght(String datasetname) throws NullPointerException, 

HDF5Exception: uses the provided API by HDF5 library to read the length of the dataset, whose 

name is given as input parameter of this method  
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 String ReadAttribute(String datasetname,String attName): reads the value of the given 

attribute from the given  dataset. It returns the retrieved value as a String object 

 

The reminder methods in this class are copied direct from the samples of HDF5 library that is available 

in the website of HDF5 group (HDF Group, 2015).  

 

1.2.6  Random Sample Generation  

The introduced classes in this section are located under de.clausthal.tu.ielf.randomGenrators package 

in the source code of GUI project of ReSUS.  

1.2.6.1 Random 

This class is implemented as a parent for two random generating classes which implement two different 

random generation methods (simple random and Sobol'). The Random class is located under the 

de.clausthal.tu.ielf.randomGenrators package in the source code of ReSUS. 

This class provides a two-dimensional array as a table to store the random generated values which is 

called a Sample. Each row in the Sample represents a Realization and each column of the Sample 

contains the values for a certain input parameter of a simulation in the Resus Framework.  

This class receives the dimensions of the Sample and generates a two-dimensional array according to 

the given values. The significant attributes of this class are described in the following table. These 

attributes are defined as protected, which makes it possible that the inherited classes from this class 

get access to these attributes for filling the table.  

Table 15. Attributes of the Random class 

Type double[][] 

Name table 

Description specifies a two-dimensional table, which keeps the generated values by 

createLookupTable() method. The first dimension is the number of simulation runs 

(realizations) and the second dimension is the number of parameters in each 

realization. The value of each dimension will be set by the constructor of the class 

Type int  

Name Realizations 

Description specifies the first dimension of the two-dimensional arrays, which are specified for 

random sample values 

Type int 

Name parameters 

Description specifies the second dimension of the two-dimensional arrays, which are specified for 

random sample values 

 

The only important method of this class is described in the following: 



53 

 

1. public void createLookupTable(): initializes the table of sample values. This method should be 

overridden by the classes which extend the current class. Each class, which extends the 

Random class, implements current method according to the designated class of the sampling 

method   

1.2.6.2 SimpleRandomGenerator 

This class extends the Random class, which is introduced in 1.2.6.1. The main functionality of this class 

is implemented within the createLookupTable() method. It overrides the createLookupTable() method 

from de.clausthal.tu.ielf.randomGenrators.Random class and populates the sample table with the 

help of java.util.Random class. The java.util.Random.nextDouble() method returns the pseudorandom 

values that are distributed uniformly.  

The SimpleRandomGenerator class provides the basic random values for various distributions. It 

means, the randomly generated double values in this class are between 0 and 1 and will be transformed 

to the new intervals according the configurations of the Distribution objects for each Parameter object.  

1.2.6.3 SobolRandomGenerator  

This class extends the de.clausthal.tu.ielf.randomGenrators.Randomclass, which is introduced in 

1.2.6.1. The main functionality of this class is implemented within the createLookupTable() method. It 

overrides the createLookupTable() method from Random class in order to fill the sample table with the 

help of Sobol' points generator based on the gray order. For more information about Sobol' sequence 

please refer to (Stephen & Frances, 2008). The implementation of the C code by Frances Y. Kuo and 

Stephen Joe is converted into java language and used in the body of sobol_points() method by this 

class. This method is introduced below: 

1. public static double [][] sobol_points(): gets the dimensions for the Sample table, N and D. 

The N stands for the number of realizations and D stands for the number of parameters. The 

initial values for staring the Sobol's sequence are provided by new-joe-kuo-7.21201 file under 

the resc folder in the source code of GUI project of ReSUS. This method reads the content of 

the new-joe-kuo-7.21201 file with the provided java.util.Scanner object and fills the table 

object with randomly generated values according to the implemented algorithm in (Stephen & 

Frances, 2008) 

Furthermore, this class provides the basic random values for various distributions. It means, the 

randomly generated double values in this class are between 0 and 1 and will be transformed to the 

new intervals according the configurations of the Distribution objects for each Parameter object.  

 

1.2.7  MVC Design Pattern 

The Model-View-Controller (MVC) design pattern of the Graphical Editing Framework (GEF) is used as 

a base for developing the graphical editor of ReSUS. The developed graphical components, which are 

implemented to create a simulation workflow, are namely ReSUSModel, InputProvider, 

ResultConverter and Connections. There are four classes for each of these graphical components which 

are developed by this MVC design pattern:  

1. A Model which holds the data. All related model classes to the graphical components of ReSUS 

are implemented under package de.clausthal.tu.ielf.resusdesigner.model in the source 

project  

2. A View component which displays the data which are holding by Model objects. Three 

graphical classes are implemented for every graphical component of ReSUS Model Designer. 

These classes are located under de.clausthal.tu.ielf.resusdesigner.figures package. For 
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example, for the ResusModel class, which is the corresponding model of the Model Frame 

objects, the following classes are implemented: 

3. ResusModelBorder: paints the designated figure for Model Frame (a blue box) in addition to 

the input and output connection points on it. It adds finally the white texts on the painted 

graphical component 

4. ResusModelFeedbackBorder: draw the borders of the designated figure for Model Frame item 

5. ResusModelFigure: implements the behavior of connection anchors for Model Frame item 

6. ResusModelFeedbackFigure: binds the designated border to the corresponding figure for 

Model Frame 

7. EditParts act as Controllers and fill the Figures, which act as Views, with the data of Model 

items in MVC design pattern (and vice versa through editing support). The 

ResusContainerEditPart class, which extends the ResusEditPart class, is the base class of all 

EditPart classes in the GUI project of ReSUS. The corresponding EditPart classes to the graphical 

components of the ReSUS Model Designer extend the ResusContainerEditPart class and are 

located under de.clausthal.tu.ielf.resusdesigner.edit package 

8. EditPartFactory creates and initializes the EditParts. In the source code of ReSUS Model 

Designer, the GraphicalPartFactory, which implements org.eclipse.gef.EditPartFactory 

interface, is responsible for generating the EditPart objects according to the introduced 

Graphical components. This class is located under de.clausthal.tu.ielf.resusdesigner.edit 

package 

9. EditPolicy contributes the behavior of defined EditPart classes. There are two important policy 

classes in the implementation of the ReSUS Model Designer, which are instantiated within 

createEditPolicies() method of ResusEditPart class. The ResusElementEditPolicy class 

implements the behavior of the graphical components in the case of delete command. The 

ResusNodeEditPolicy class implements the behavior of the graphical components by creating 

connections between them  

10. An object of the GraphicalViewer class contains the figures and takes care of displaying. In 

addition, it handles the calls on methods of its including figures  

For more information about MVC structure of ReSUS Model Editor please refer to (Clayberg, 2008) and 

(Rubel, 2011). 

 

1.2.8  Distributions 

Probabilistic distributions, which are used as a part of the configuration for input parameters of the 

ReSUS simulation models, are implemented as five various classes. All of these classes extend the 

de.clausthal.tu.ielf.randomGenrators.distributions.Distribution class. These classes are available 

under the de.clausthal.tu.ielf.randomGenrators.distributions package.  

The de.clausthal.tu.ielf.randomGenrators.distributions.Distribution class implements Serializable 

interface that makes it possible to write and load the objects of this class within the Parameter object 

into/from the binary files. The attributes of this class are introduced in Table 16. 

Table 16. Attributes of the Distribution class 

Type Java.lang.String 

Name name 

Description is designated to distinguish the type of the classes that extend the Distribution class. 

It is used especially in the ParameterNewDialog and ParameterEditDialog class for 
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deciding about showing or hiding some parts of the configuration fields according to 

the selected distribution type by the user  

Type double 

Name primitiveValue 

Description should be a double value between 0 and 1. The random generator classes in GUI 

project of Resus (simple random or Sobol') generate the random values between 0 

and 1, which transforms into an interval configured by the user. This values will be 

stored within the current attribute 

Type Map<String, Double>  

Name Parameters 

Description provides the ability to save some properties and their related values for different 

classes which extend the Distribution class 

Type static final String 

Name MIN_VALUE 

Description is the string value as key for storing a double value by parameters Map object. This 

double value specifies the lower boundary for the probability distribution, which is 

implemented via object of this class  

Type static final String 

Name MAX_VALUE 

Description is the String value as key for storing a double value within parameters object, which is 

an instance of Map class. This double value specifies the upper boundary for the 

probability distribution, which is implemented via the object of this class 

 

Each class that extends the Distribution class should implement the public double next() which is the 

most significant method of this class. This method transfers the primitive value into the boundaries 

and its measures, which are specified by the parameter distribution, and returns it. This method will 

be invoked using polymorphism concept within various classes which implements different types of 

distributions for sample generation wizard (See 1.2.5.2).  

1.2.9  Communicating with Core Component of ReSUS 

The communication with Core component of ReSUS is implemented via two Button controls, which are 

responsible for executing two Command classes. They enable the user to invoke the Core component 

of ReSUS for performing a simulation in the single and parallel mode. These Command classes are 

added to the Extensions of GUI project of ReSUS under org.eclipse.ui.commands (See Figure 36).  



56 

 

 

Figure 36. Extensions and Extension points for providing commands and menu buttons 

In order to show the button for starting the Resus simulations within the Menu and Toolbar of the 

ReSUS Model Designer, they should be registered Extensions for GUI project of ReSUS. Figure 36 depicts 

these button items that are registered as Extensions for GUI project of ReSUS under org. 

eclipse.ui.menus in the MANIFEST file.  

 

Figure 37. Assigning the menus items to the corresponding Command items 

Figure 37 depicts how the inserted items under org.eclipse.ui.menus in Extensions are connected to 

their corresponding Commend items. One can see that the Command Id field on the right side of the 

Figure 37 refers to the command item with the given id. The referred command item should be located 

under the org.eclipse.ui.commands extension. 

 

Figure 38. Assigning the Command items to the Handler items in the Extensions 

Figure 38 depicts the entries of org.eclipse.ui.handlers Extension which are responsible for connecting 

the Command items to the related Classes in the source of the ReSUS GUI project. On the right side of 

Figure 38, one can see that the given command for single execution is connected to the singlesimulate 
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class. This class that was introduced in 1.2.9.1 is located under the resus.handlers package in the source 

of GUI project of ReSUS.  

1.2.9.1 singlesimulate 

The class singlesimulate, which is located under the resus.hanlders package, is responsible for the 

execution of ReSUS core with the proper input parameters. In order to use this class as a handler of the 

commands, this class should extends the org.eclipse.core.commands.AbstractHandler. In addition, 

the envisaged operations for the assigned command to this task are implemented within the 

overridden execute() method of this class. This method is introduced in the following:  

1. public Object execute(ExecutionEvent event) throws ExecutionException : performs the 

executable of the Core component (resusCore.exe) as a command in the level of underlying 

operation system. Furthermore, it reports the execution status and sends the output of the 

standard console into the Console View ReSUS Model Designer. This method will throw an 

exception if the executable of the core component is not available 

1.2.9.2 multiSimulate 

This class is very similar to the singlesimualte class that was introduced in 1.2.9.1. The only difference 

is in the command line parameters that will be sent to the Core component. The number of thread 

should be considered in the command line parameters in the parallel simulation mode. This values will 

be submitted by the user via an instance of selectThreadsDialog class. This class is located under the 

same package as the one which stores the singlesimulate and multiSimulate classes.  

1.2.10  Interface to Analyzer Tool of ReSUS 

The Outputview which is presented in1.2.3.10 is registered as an extension in the Manifest file under 

org.eclipse.ui.views (See Figure 39). 

 

Figure 39. Output Viewer as a new View in ReSUS Model Designer 

Figure 39 depicts the corresponding class to this View and its implementation under the 

de.clausthal.tu.ielf.resus.views with the name of OutPutView. This class is responsible for creating the 

request files in XML format and invoking the executable files of the ReSUS Analyzer Tool, namely 

ResusCharts.exe and resusExport.exe.  
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1.2.11  ResusSettings 

The ResusSettings class, which is located under de.clausthal.tu.ielf.resusdesigner package is provides 

the full path to the executable files of ReSUS components(Core and Analyzer Tool). The components of 

the ReSUS are stored under the %RESUS_HOME%, which are added to the system variables before 

starting the ReSUS Model Designer. Table 17 introduces the attributes of this class.  

Table 17. Attributes of the ResusSettings class 

Type Java.lang.String 

Name Core 

Description specifies the full path to the resusCore.exe file. This attribute will be initialized by 

constructor method of the ResusSettings class 

Type Java.lang.String 

Name chart 

Description specifies the full path to the resusCharts.exe file. This attribute will be initialized by 

the constructor method of the ResusSettings class 

Type Java.lang.String 

Name Export 

Description specifies the full path to the resusExport.exe file. This attribute will be initialized by 

the constructor method of the ResusSettings class 

 

The significant methods of this class are introduced below: 

 public ResusSettings(): initializes the core, chart and export attributes of this class according 

to the given path as the value of %RESUS_HOME% system variable. In addition, this method 

validates the given path to these executables 

 public static Path checkReSUS_HOME(): validates the given address as the value of 

%RESUS_HOME% and shows the proper message if the given path is not valid or does not exist  

 public static Path chekReSUS_HOME_core(): returns a path to the executable file of the ReSUS 

Core component (resusCore.exe). Additionally, this method validates the existence and the 

type of the generated path in order to prevent failures throughout the simulation  

 public static Path chekReSUS_HOME_chart(): returns a path to the executable file of ReSUS 

Chart Tool. Additionally, this method validates the existence and the type of the generated path 

in order to prevent failures throughout post-processing operations 

 public static Path chekReSUS_HOME_regex(): returns a path to the executable file of 

additional simple Regex checker tool, which is delivered with the Resus installation package. 

Additionally, this method validates the existence and the type of the generated path 

 public static Path chekReSUS_HOME_export(): returns a path to the executable file of the 

ReSUS Export Tool. Additionally, this method validates the existence and the type of the 

generated path in order to prevent failures throughout the post-processing operations 

1.3 Analyzer Tool 
Analyzer Tool consists of two components (Chart Tool and Export Tool) for visualizing the results of the 

probabilistic simulations and are performed by ReSUS Core. Both tools are developed as C++ projects 
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under Qt framework. The structure and the components of these projects are introduced and 

described in the following subsections. 

These projects utilize the provided Widget and libraries by Qt for creating controls such as dialog boxes, 

frames, buttons, textboxes and combo boxes. In addition, both of these projects consist of an 

application and a library sub-projects. Packing the functional part of the project as a library subproject 

makes it possible to use the functionalities of these tools in other projects and sensitivity analysis tools.  

1.3.1  Chart tool 

This Project is located under Charts folder of the ReSUS Source package, which can be opened with Qt 

Creator.   

The Charts.pro file specifies the structure of the Chart project and its subprojects. This project consists 

of an application and a library subproject which are introduced as follows.  

1.3.1.1 Application  

The ResusCharts.pro file, which is located under ResusCharts folder contains the configuration of this 

subproject. This project utilizes the QWT library in order to generate charts, as well as Boost library in 

order to parse the XML files. Figure 40 shows a part of the ResusCharts.pro file, in which the QWT and 

Boost libraries are assigned to this project. For more information about API and functionalities of QWT 

please refer to the website of QWT library (Rathmann & Wilgen, 2016). 

 

Figure 40. Assigning the QWT libraries to the Charts project 

The output of this project is specified as an application, which is considered by the TEMPLATE and the 

TARGET directives in the ResusCharts.pro file. In addition, this file contains a list of the assigned sources 

and header files of the project.  

1.3.1.1.1 Main.cpp 

This file contains the main() method as the starting point of the application. This method is introduced 

below: 

1. int main( int argc, char **argv ): reads the sends strings as command line arguments to this 

application. These input strings are considered by argv variable. The argv[1] should contain an 

string as the full path to an XML file, which contains the configurations for the drawing charts. 

This method creates an instance of MainWindow and shows it. In addition, the main() method 

passes the path to the XML file as input parameter to the instantiated object of MainWindow  

1.3.1.1.2 MainWindow 

This class is responsible for showing the main window of the Chart Tool for the Analyzer Tool. The 

MainWindow class extends the qmainwindow from the QT graphical library.  The attributes of this class 

are introduced in Table 18. 
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Table 18. Attributes of the MainWindow class  

Type QwtPlot* 

Name d_plot 

Description specifies a pointer to an instance of QwtPlot, which will be used to generate and show 

the charts  

Type Panel* 

Name d_panel 

Description specifies an instance of the Panel object, which will be placed on the left hand side of 

the MainWindow window and provides the required controls for configuring the 

charts  

Type QPushButton* 

Name btnExportCurve 

Description provides a pointer to instantiate a Button control on the MainWindow in order to 

trigger the corresponding method for exporting the shown charts on the d_plot into 

an image file 

 

The important methods of this class are introduced as following:  

 MainWindow::MainWindow( QWidget *parent ,string parameterfilename): is the 

constructor method of this class with two additional parameters. The second parameter of this 

method specifies the full path to an XML file, which contains the data sources and additional 

information about the values that should be used for drawing charts. This method parses the 

XML files and creates some instances of ChartItem class according to the given information in 

the XML files. This method initializes the d_panel pointer with a new Panel object. 

Furthermore, this method initializes the required objects for assigning legend and zooming 

functionalities into the charts  

 void MainWindow::on_btnExportCurve_clicked(): is implemented as a slot, which handles the 

click events on the btnExportCurve. This method utilizes the exportTo() method of the 

QPlotRenderer class in order to export the generated chart as image files. The exrportTo() 

method shows a dialog to the user for collecting the path and file formats (pdf, jpg, png) before 

starting the export operation. The default path of this dialog is set with the path to the desktop 

of the current user and operating system  

1.3.1.1.3 Panel 

This class, which extends the QTabWidget class, is responsible for generating a toolbox at the left side 

of the MainWindow of the Chart Tool for configuring the charts. The Panel class contains the controls 

which are defined in the header file of the Panel class. In addition, its header file contains other three 

important attributes of this class, which are introduced in Table 19.  

Table 19. Attributes of the Panel class 

Type MainWindow* 

Name Mainwindow 
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Description specifies a pointer to the MainWindow object, which contains the current instance of 

the Panel object  

Type std::vector<ChartItem> 

Name chartItems 

Description specifies a collection of ChartItem objects, which will be passed to the ChartFactory 

object to generate the charts with regarding to the inputs of Chart Tool  

Type QwtPlot* 

Name myplot; 

Description specifies a pointer to an instance of the QwtPlot object. It provides access to the 

Charts that will be generated by the ChartTool and shown on the MainWindow object 

 

The slots enable the developers to handle clicks and bind them to the proper method for drawing 

different charts. They are defined in the header file of the Panel class as follows:  

private Q_SLOTS: 
 
    void on_btnDrawCurve_clicked(); 
    void on_btnDrawPlot_clicked(); 
    void on_btnDrawHistogram_clicked(); 
    void on_histogramQuantityOfInterest_changed(); 
    void on_plotQuantityOfInterest_changed(); 

 

The important methods of the Panel class are described below:  

 Panel( QWidget *parent,MainWindow* mw ,vector<ChartItem> & _chartItems): is the 

constructor of this class that initializes the member variables with the values of its input 

arguments. In addition, this method invokes three other member methods to create three side 

tabs on the Panel object. Furthermore, it initializes the slots that are designated to handle the 

clicks on the Button controls(click listeners) 

 QWidget *createCurveTab( QWidget * ): creates and returns a pointer to an object from the 

QWidget class as a side tab on the Panel object. The input parameter of this method will be 

used to specify the parent of the generated tab. This method is responsible for generating and 

ordering the controls on designated side for Curves (line charts). In addition, the values of the 

combo box items will be initialized according to the current ChartItem objects in the chartItems 

which is a member attribute of the Panel class  

 QWidget *createPlotTab( QWidget * ): creates an object from QWidget class as a side tab on 

the Panel object and returns a pointer to it. The input argument of this method will be used to 

specify the parent of the generated tab. This method generates and orders the required 

controls on Plot tab. In addition, the values for the combo box items will be initialized according 

to the existing ChartItem objects in the chartItems which is a member attribute of the Panel 

class  

 QWidget *createHistogramTab( QWidget * ): creates an object from QWidget class as a side 

tab on the Panel object and returns a pointer to it. The input argument of this method will be 

used to specify the parent of the generated tab. This method generates and orders the controls 

on Histogram tab. In addition, the values of the combo box items will be initialized according 

to the existing ChartItem objects in the chartItems which is a member attribute of the Panel 

class  
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Hint: The combo boxes in each tab contain a list of names of the parameters, which are loaded from 

the binary files. The chartItems object which are passed from an object of the MainWindow class to 

this class prepare the required information to fill these combo boxes in each of the methods above by 

the means of for-loops. 

 void on_btnDrawCurve_clicked(): will be invoked if the user clicks on the Draw button of the 

Curves tab. This method gathers the selected configurations by the user from controls on the 

tab and sends them to an instance of the ChartFactory object. The drawCurve() method of the 

ChartFactory class is responsible for getting these information as input parameters and 

returning a pointer to an object from QwtPlot class, which contains the generated line charts. 

The MainWindow class copies the content of this pointer into a member attribute of itself 

which is designated for visualizing the charts on the instance of the MainWindow class 

 void on_btnDrawPlot_clicked(): will be invoked if the user clicks on the Draw button on the 

Curves tab. This method gathers the selected configurations by the user from controls on the 

tab and sends them to an instance of the ChartFactory object. The drawPlot() method of the 

ChartFactory class is responsible for getting these information as input parameters and 

returning a pointer to an object from QwtPlot class, which contains the generated scatterplot 

charts. The MainWindow class copies the content of this pointer into a member attribute of 

itself which is designated for visualizing the charts on the instance of the MainWindow class 

 void on_btnDrawHistogram_clicked(): will be invoked as a user clicks on the Draw button on 

the Curves tab. This method gathers the selected configurations by the user from controls on 

the tab and sends them to an instance of the ChartFactory object. The drawHistogram() 

method of the ChartFactory class gets these information as input parameters and returns a 

pointer to an object from QwtPlot class, which contains the generated histogram chart. The 

MainWindow class copies the contents of this pointer into a member attribute of itself which 

is designated for visualizing the charts on the instance of the MainWindow class 

1.3.1.2 Library  

This subproject provides the possibility to read the values from the binary files (data sources), organizes 

and visualizes them as the charts. The source code for the library part of the Chart Tool is located under 

the ResusChartsLib project. This project is created with the help of Qt Creator and developed with the 

C++ language. This subproject implements the main functionalities of the Chart Tool for generating 

various charts and diagrams. Figure 41 depicts the usage of TARGET, TEMPLATE and CONFIG directives 

in the ResusChartsLib.pro file, which specifies that this project generates a static library with the name 

of ResusChartsLib.lib. The Qt -=GUI instruction shown in the Figure 41 specifies that This project does 

not contain any graphical user interface. 

 

Figure 41. Configuring the ResusChartsLib to generate a static library 

The main classes of ResusChartsLib subproject are introduced as next.  
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1.3.1.2.1 ChartItem 

The submitted XML file as an input for the Chart Tool, should contain certain <chartItem> nodes. Each 

<chartItem> node contains a child node which keeps a full path of a binary file, and a child node which 

contains a label (name) for that binary file. The binary files contain the results of the probabilistic 

simulations, which are performed by Core of ReSUS. The binary files contain additional information 

about the parameters, which are used as inputs of the simulation. Furthermore, the binary files contain 

the values and the information of the parameters that are specified as the outputs of the simulation. 

An index for each parameter, which is stored in the binary files, is provided via ChartItem class. The 

constructor method of the MainWindow Class in the application subproject of ResusChart is 

responsible for extracting the information about the parameters from the binary files and storing them 

as a collection of the ChartItem objects. The objects of the ChartItem class are used to enable the user 

to configurate chart types and select the values of the parameters which should be visualized within 

the charts. Table 20 introduces the attributes of the ChartItem class which keep the information about 

the parameters in the binary files.  

Table 20. Attributes of the ChartItem class 

Type std::string 

Name fileName 

Description contains the full path to the binary file, which contains the results of the probabilistic 

simulations  

Type std::string 

Name Title 

Description specifies the name of the assigned parameter from the binary file to the current 

ChartItem object 

Type std::string 

Name Unit 

Description specifies the unit of the assigned parameter from the binary file to the current 

ChartItem object 

Type int 

Name parameterIndex 

Description specifies the index of the assigned parameter from the binary file to the current 

ChartItem object. For more information about index of the parameters please refer to 

1.1.6 and 1.2.5.2.1 

 

1.3.1.2.2 ChartFactory 

The ChartFactory class is the most significant class in the ResusChartsLib project. It provides the 

required functionalities for generating charts as QwtPlot objects. These objects will be illustrated as 

charts on the MainWindow. The mainly methods of this class are introduces below:  

 QwtPlot* drawCurve(QwtPlot *m_plot, ChartItem &xitem, bool xlog, ChartItem &yitem, 

bool ylog, bool max, bool min, bool median, bool mean, vector<int> quantiles): generates an 
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QwtPlot object and returns a pointer to it. The ChartItem objects which are given as the second 

and the third input arguments to this method specify the configurations for X axe and Y axe. 

Note that, these curves are the time dependent values in which the X axe shows the time line 

and the Y axe shows the values in each point of the time. It means, in most cases the values in 

xitem are the same for all the curves. Therefore, the following Boolean parameters of the 

current method enable some additional operations on the Y values on the chart:  

a. bool min: when this parameter is true, the drawCurve() method finds the minimum of 

values in yitem according to each index of xitem  array.  It draws the minimum values 

as a curve on the final chart  

b. bool max: when this parameter is true, the drawCurve() method finds the maximum 

of values in yitem according to each index of xitem  array.  It draws the maximum values 

as a curve on the final chart 

c. bool median: when this parameter is true, the drawCurve() method calculates the 

median value of values in yitem according to each index of xitem  array.  It draws the 

calculated median values as a curve on the final chart 

d. bool mean: when this parameter is true, the drawCurve() method calculates the mean 

value of values in yitem according to each index of xitem  array.  It draws the median 

values as a curve on the final chart 

The xlog and ylog parameters specify the logarithmic transformation of xitem and yitem before 

visualizing them on the chart.  This method uses the ChartItem objects to retrieve the values 

of the parameters from binary files. Each parameter should be assigned only to one object of 

ChartItem. It throws an exception if the binary file to the given ChartItem object doesn’t 

contain values for its assigned parameter  

 QwtPlot* drawHistogram(QwtPlot *myPlot, ChartItem &item, bool xlog, int 

numberOfBeans, ChartItem &quantitiyOfInterestSource, ChartFactory::QuantityOfInterest 

quantityOfInterest): generates an QwtPlot object and returns a pointer to it. The ChartItem 

object as input parameters of this method specify the values, which their frequency should be 

drawn as histogram. Furthermore, the true values of the Xlog argument specifies the 

transformation of the values into logarithmic scales. The quantitiyOfInterestSource argument, 

which is an instance of ChartItem class, specifies the used parameters for calculating the 

various quantity of interest functions. The implementation of quantityOfIntereset methods are 

introduces in (Ghofrani J. , 2016). The last input argument of this method decides about the 

type of the quantity of interest function. Each parameter should be assigned only to one object 

of ChartItem. This method throws an exception if the given binary file to the ChartItem object 

doesn’t contain the expecting values for assigend parameter  

 QwtPlot* drawPlot(QwtPlot *scatterPlot, ChartItem &xitem, bool xlog, ChartItem &yitem, 

bool ylog, ChartItem & quantityOfInterestSource, ChartFactory::QuantityOfInterest 

quantityOfInterest, bool lineRegression, bool cosiRegression): generates an QwtPlot object 

and returns a pointer to it. The second and forth argument of this method, which are objects 

of ChartItem class, specify the configurations for X axe and Y axe. Furthermore, the true values 

of the Xlog and Ylog parameters enable the logarithmical transforming on the X and Y values 

before visualizing them on the chart. In the scatterplot charts, for each realization is only one 

value allowed. This value will be generated by specified object as QuantityOfInterest argument 

of this method. The implementation of quantityOfIntereset methods are introduces in 

(Ghofrani J. , 2016). The two last input parameters of this method enable the calculation of the 

linear and cosines regressions for the plotted values. Each parameter should be assigned only 
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to one object of ChartItem. This method throws an exception if the given binary file to the 

ChartItem object doesn’t contain values for assigned parameter  

 bool get(string fileName,int reqId, vector<Realization>& ): loads only the values of a certain 

parameter from the binary file which is specified by fileName parameter. The id of the 

parameter that should be retrieved from the binary file is specified by the value of reqId. The 

retrieved values will be kept in a vector of Realization objects which is defined as third input 

parameter of current method. This method returns true if the operation is successfully 

performed, otherwise false 

 QwtPlotCurve *linearRegression( double* xvalues,double*yvalues, int length): calculates the 

linear regression, i.e. Y=f(X) function, from the values for X and Y. The linear regression function 

will be visualized as an QwtPlotCurve object. This method returns a pointer to the generated 

QwtPlotCurve object which will be used within the drawPlot() method   

 QwtPlotCurve* CosiRegresssion( double* xvalues,double*yvalues, int length): calculates the 

non-linear regression of the given values for X and Y. In addition, it visualizes the calculated 

regression function by the means of a QwtPlotCurve object. Finally, this method returns a 

pointer to the generated QwtPlotCurve object, which will be used within the drawPlot() 

method  

 double ChartFactory::vsi(double *x, double *y, double *xy, double* yhat, int n): this method 

helps the CosiRegresion() method to calculate the sensitivity index 

1.3.2  Export tool 

Export Tool is a part of the Analyzer Tool which is one of the three basic components of the ReSUS 

Platform. This Project is located under Export folder in the package of the ReSUS Source. The Export.pro 

file declares the structure of the Export project and its subprojects. The Export project consists of an 

application and a library subprojects which are introduced as next.  

1.3.2.1 Application 

The ResusExport.pro file is located under ResusExport folder. It contains the configuration of 

application subproject of the Export Tool. This project utilizes the xlslib library to generate XLS files 

(Microsoft Excel) and the Boost library to parse the XML files. Figure 42 depicts a part of the 

ResusExport.pro file in which the xlslib and Boost libraries are assigned to this subproject. For more 

information about API and functionalities of xlslib and boost please refer to (xlslib, 2016) and (Boost , 

2016). 

 

Figure 42. Assigning the xlslib and Boost libraries into the ResusExport subproject 

The output of ResusExport subproject is specified as an executable which is considered as application 

by TEMPLATE and TARGET directives in the ResusExport.pro file. Furthermore, the ResusExport.pro file 

contains the list of the assigned source and header files to the ResusExport subproject. The significant 

classes of this project are introducing as next.  
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1.3.2.1.1 Data Models 

Working with QTableView and QTreeView objects in Qt does not seem easy, but there is a simple 

model/view concept behind them. In the model/view approach, these objects do not contain the data 

directly. They access an external data source via a standardized interface, which is called 

QStandardItemModel. This model contains the information and will be set to the QWidget items (e.g. 

QTableView and QTreeView inhert from QWidget class) by their setModel() method.  

According to the tutorials of the Qt (Qt Company, 2016), there are two types of data model for showing 

the data within QTableView and QTreeView objects (See Figure 43). Each node of the Tree Model in 

Figure 43 is an instance of the QStandardItem class. 

 

 

Figure 43. Data Models which are used by Table and Tree in Qt (Qt Company, 2016)  

1.3.2.1.2 MainWindow 

The MainWindow class enables the user to interact with Export Tool of Resus. It Provides a visual 

interface to enable the user to query and export the results of probabilistic simulations from the binary 

files. This class extends the QMainWindow class and adds an instance of the Panel class (See 1.3.2.1.3) 

to it. The Panel class contains the required controls for selecting the results of probabilistic simulations 

and displaying them in tabular format. The Panel class provides the required controls for exporting the 

simulation results as XML and XLS files. The only important method of this class is the constructor. The 

constructer parses the given XML file and generates some ExportItem object with regarding to the 

stored parameters in the binary files. Furthermore, the constructor initializes the Panel object and 

binds it to the current instance of the MainWindow class.   

1.3.2.1.3 Panel 

The Panel class provides the interaction between the user and the instance of MainWindow class. it 

consists of two tabs which contains two type of functionalities for displaying the simulation results. The 

first tab contains a TreeView control and two Table controls. The TreeView control enables the user to 

see a list of realizations and select one of them. The values of the input and output parameters of the 

selected realization will be displayed by the instance of Table class. The second tab contains two 

TreeView for enabling the user to select the input and output parameters and an instance of 
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QTableView class to show the correlation between the selected input and output parameters.  The 

most important members of this class are introduced in Table 21.  

Table 21. Attributes of the Panel class 

Type Table * 

Name d_tables 

Description a pointer to the instance of the Table class. The selected realization by the user on the 

instance of the TrVwRealization class specifies the realization which should be 

displayed by this object of Table class. For more information about Table class please 

refer to 1.3.2.1.4. 

Type QStandardItemModel* 

Name CorelationModel 

Description provides a pointer to an instance of the QsStandardItemModel class which is used as 

a data model to store and manage the correlation values. This data model will be used 

by the corelationsTable object.  

Type QTableView*  

Name corelationsTable 

Description provides a pointer to an object of QTableView class which shows the values of 

correlations between the selected input and output parameters  

Type vector<ExportItem>  

Name exportItems 

Description is a vector of ExportItem objects. Each simulation parameter can be assigned to one 

object of ExportItem class. The Panel class uses these objects to enable the user to 

select the certain parameters, and not all the of them. It makes the calculation of 

correlation as well as export of the simulation results more simple. 

Type QTreeView* 

Name TrVwRealization 

Description is a pointer to an instance of QTreeView class which shows the list of realizations. It 

enables the users to click a realization for displaying the input and output values. 

additionally, the tree nodes enable the user to select some or all realizations to export 

their contents   

 

The important methods of this class are introduced below: 

 QWidget *createRealizationsTab( QWidget * ): creates a tab which contains the required 

controls for enabling the user to select a realization by clicking on it. The values of input and 

output parameters of the selected realization will be displayed by d_tables object. It also 

initializes an object of Checkableproxymodel class and assigns it to the TrVeiwRealization object 

for managing the click and check events on TrVeiwRealization object. This method returns a 

pointer to the created tab object 
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 QWidget *createCorelationsTab( QWidget * ): creates a tab which contains the required 

controls for enabling the user to select input and output parameters for calculating their 

correlation. It initializes the lists to select the input and output parameters as well as the  

corelationsTable object. This method returns a pointer to the generated tab 

 void on_treeViewSelectionChanged(): handles the click events on the TrVwRealization object. 

It does not control the changes in the checkboxes within TrVwRealization. This method will be 

only triggered if the user clicks on any node of the Tree control. Triggering this method will load 

the related input and output values to a realization that is assigned to the clicked tree node 

 void ExportCheckedRealizationsToFile(): will be invoked by click handler of the 

btnExportSelectedRealizations object, which is located on the Panel class and is also connected 

to the on_btnExportSelectedRealizations_clicked() method. The 

ExportCheckedRealizationsToFile() method retrieves the status of checked nodes in the 

TrVwRealization object by asking the m_checkProxy object. Furthermore, it invokes the 

designated method from ExportItem class to export the values into the specified file path and 

in the selected format by the user. according to the selected configuration 

1.3.2.1.4 Table 

This class inherits from QWidget class and displays the values of input and output parameters for a 

certain realization, which is selected by the user within TrVwRealization object, in the tabular format. 

It contains two instance of QTableView class as well as their data models which are introduced in Table 

22. 

Table 22. Attributes of the Table class 

Type QTableView*  

Name inputTable 

Description is a table control to display the values of the input parameters from the selected 

realization  

Type QTableView*  

Name outputTable 

Description is a table control to display the values of the output parameters from the selected 

realization 

Type QStandardItemModel* 

Name inputTableModel 

Description is a two-dimensional matrix as data model for keeping the values of input parameters 

which will be displayed within inputTable control 

Type QStandardItemModel* 

Name outputTableModel 

Description a two-dimensional matrix as data model for keeping the values of output parameters 

which will be displayed within outputTable control 

 

The important member methods of this class are introduced as below:  
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1. void setInputTableDataModel(QStandardItemModel* inputTablemodel): sets the data model 

of the inputTable object with an object which is given to this method as input argument. This 

method resizes the header of the table columns to fill the whole width of the table  

2. void setOutputTableDataModel(QStandardItemModel* outputTablemodel): sets the data 

model of the outputTable object with an object which is given to this method as input 

argument. This method resizes the header of the table columns to fill the whole width of the 

table 

1.3.2.1.5 CheckableProxyModel 

Although the provided Data Model structure by Qt, which is mentioned in 1.3.2.1.1, enables the 

developer to show the data within QTreeView objects, this functionality is not enough to shoe the tree 

nodes in QTreeView as checkable boxes. The CheckableProxyodel class implement the possibility to 

show the tree nodes as checkboxes and to get access to the status of checkboxes (checked/unchecked). 

This class is a part of the ArpmanetDC project and is available under the GitHub page of this project 

(zAAmpie/arpmanetdc , 2016). The checkedState() method of this class is used to collect the checked 

root nodes and checked child nodes from the assigned data model to the tree control. 

 

1.3.2.1.6 TreeItemValue 

This class implements an enumeration for signing the nodes of the TrVwRealization control on the Panel 

class. The constant static attributes of this class are used as key to specify the Id of the items which will 

be stored within an QStandardItem objects. These enumerations are used as input of the setData() 

method from QStandardItem. They specify the type of the given value as input parameter to the 

setData() method. The TreeItemValue::exportItemIndex specifies the index value of the ItemIndex 

object which is assigned to the instance of QStandardItem class. The TreeItemValue::realizationIndex 

specifies the index value of the realization which is assigned to the instance of QStandardItem class. 

The QStandardItems will be used as data model to show the realizations as nodes of the 

TrVwRealization control. The root nodes display the binary files which are specified by ItemIndex items. 

The subnodes of under a file node show the realizations which are stored in it.  

1.3.2.2 Library  

This subproject  is the library part of the Export Tool and provides the required functionalities for 

reading the values from the binary files into the data model objects. It also provides the required 

functionalities for exporting the simulation values as various data formats into the files on the disk.  

The source code of this subproject is located under the ResusExportLib project. Figure 44 depicts the 

usage of TARGET, TEMPLATE and CONFIG directives in the ResusExportLib.pro file, which specifiy that 

this project generates a static library with the name of ResusExportLib.lib. Furthermore, the Qt -=GUI 

command in Figure 44 declares that this project doesn’t contain any graphical user interface. 
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Figure 44. The configurations of ResusExportLib to generate a static library 

The most important class of this project is the ExportItem class. This class is introduced as next.  

1.3.2.2.1 ExportItem 

This class is the mapping of the items of the input of the Export Tool into the memory. The XML files 

which will be submitted as input to the Export Tool should contain some <exportItem> nodes. Each 

<exportItem> node contains a <fileName> node and a <title> node. The <fileName> node contains the 

full path to a binary file and the <title> node contains the label for that binary file. Figure 45 depicts an 

example in which the details of the <exportItem> nodes are visible. 

 

Figure 45. An example of the content of the input of Export Tool 

The binary files contain the results of the probabilistic simulations and additional information about 

them. This information includes the parameters which are used as input and the ones which are 

specified as output of the simulation. The objects of the <exportItem> class provide an index for each 

binary file, whose content should be accessible via Export Tool. Each binary file will be shown as a root 

node in QTreeView control on the Panel class. This objects provide the access to the content of the 

binary file such as retrieving the maximum number of realizations that are stored in the binary files, or 

the retrieving the values of input and output parameters from a binary file for a certain realization and 

storing them in an object of QStandardItemModel. The objects of the QStandardItemModel class are 

used to show the data within tables in Qt projects. This class provides some methods to extract the 

input and output values of the simulation parameters from the binary file and store them as text or 

excel formatted files. The attributes of this class are introduced in Table 23. 

Table 23. Attributes of the ExportItem class 

Type std::string 

Name fileName 

Description contains the full path to the binary file, which contains the results of the probabilistic 

simulations.  
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Type int 

Name numberOfRealizations 

Description specifies how many realizations are stored in the given binary file. The 

getNumberOfRealizations() method initializes this attribute 

Type QStandardItemModel* 

Name Model 

Description is a pointer to a data model object. This object will be created by the getModel() 

method and returned to the instance of current class 

 

The important methods of this class are introduced below: 

 std::map<int,string> getParameters(int paramType): retrieves the information about the 

parameters from the binary file. It retrieves the information about input or output parameters. 

the type of the parameters is specified by the given paramtType as input parameter of this 

method.  The retrieved information will be converted and returned as a map. The key values 

of this map are the integer value which specify the index of the parameters with regarding to 

the given type. The Values of this map are string values which specify a combination of labels 

and units of retrieved parameters. The 0 and 1 are valid values for paramType argument. The 

value 1 for paramType returns the information about input parameters from the binary file. 

The value 0 for paramType returns the information about output parameters from the binary 

file. The binary file is accessible via fileName attribute of current class 

 std::vector<double> getParameterMaximumValues(int reqId): finds and extracts the 

maximum values of a certain parameter, which its index is specified by reqId argument,  in each 

realization and returns them as an vector of double values. This method will be used by Export 

Tool to calculate the correlation index between input and output values  

 QStandardItemModel* getModel(int realizationNumber, int type): retrieves the input or 

output values of a certain realization. The  realization is specified by the first parameter of this 

method, realizationNumber. The second parameter of this method, int type, specifies the input 

or output parameters of the given realization should be retrieved. The 1 as value of type 

argument specifies that the all input parameters values of the given realization should be 

extracted. The 0 as value of this parameter specifies that the all output parameters values of 

the given realization should be extracted. The retrieved values will be converted to an object 

of QStandardItemModel class and a pointer to this object will be returned by this method. This 

method is used in Panel from ResusExport project. It  fill the data model of the tables which 

displays the input and output of a realization which is selected by user  

 bool saveAsXls(string dir, vector<int> selectedRealizations, bool inputValues, bool 

outputvalues, bool maximum,bool singleSheet): extracts the realizations which are identified 

with selectedRealizations argument and export them  in a Microsoft Excel formatted file. The 

dir argument specifies the path to this Microsoft Excel formatted file. The Boolean argument 

inputValues denotes whether the values of the input parameters from the given realizations 

should be extracted and stored in the exported file. The Boolean argument outputValues 

denotes whether the values of the output parameters from the given realizations should be 

extracted and stored in the exported file. The Boolean parameter maximum decides whether 

all the values of a realization should be stored, or only the maximum values of each parameter 

in each realization should be calculated, extracted and stored within the exported file. The True 

value of the singleSheet argument specifies that the values of all realization should be stored 



72 

 

as a single sheet in the Microsoft Excel formatted file. Setting this parameter to False will store 

the related values to each realization in a separated single sheet 

 bool saveAsText(string dir, vector<int> selectedRealizations, bool inputvalues, bool 

outputvalues, bool maximum, bool singleSheet): extracts the realizations which are identified 

with the selectedRealizations argument and export them  in a comma separated values (CVS) 

formatted file. The dir argument specifies the path to the comma separated values (CVS) 

formatted file. The Boolean argument inputValues denotes whether the values of the input 

parameters from the given realizations should be extracted and stored in the exported file. The 

Boolean argument outputValues denotes whether the values of the output parameters from 

the given realizations should be extracted and stored in the exported file. The Boolean 

parameter maximum decides whether all the values of a realization should be stored, or only 

the maximum values of each parameter in each realization should be calculated, extracted, 

stored within the exported file. The value of the singleSheet argument specifies if for each 

realization should a file generated. Setting this parameter to true will store all the values in a 

single file, otherwise the values of parameters of each realization will be stored in a separated 

text file 

 std::map<string, vector<double> > getRealizationValues (long realizationNumber, bool 

inputs, bool outputs): retrieves the values of a realization according the given configurations.  

The first argument of this method specifies the index of the required realization. The second 

argument, bool inputs, specifies whether the values of input parameters in the given 

realization should be returned. The third argument, bool outputs, specifies whether the values 

of output parameters of the given realization should be returned. In order to retrieve both 

input and ouput values from a realization, both of these arguments should be set to True. The 

retrieved values by this method will be packed as a map object of strings and vector of doubles. 

The key values of this map object are the string variables which contains of the name and the 

unit of the retrieved parameters. Each parameter is specified with a string, which consists of 

name and unit of that parameter, and is mapped to a vector of double values which contains 

the values of that parameter within a certain realization 

 

1.3.3  Unit test 

The unit tests are designated for only the library subprojects of the ResusCore, ResusCharts and 

ResusExport, it means the Core and Analyzer Tool.  Each of these subprojects consists of application, 

library and a test subproject. The test subproject contains the units of Boost Test Suites which are 

written for the located classes under the library subproject. These tests check the member methods of 

these classes to find whether they return the expected values.  

The general structure of Boost Test Suite (Boost , 2016), which is used in source code of Core and 

Analyzer Tool of ReSUS, is described in this part. Each test suite must begin with 

BOOST_AUTO_TEST_CASE expression and a parameter in parentheses, which represents the name of 

the test suite. The Boost_TEST_CASE is a block, which should be ended by 

BOOST_AUTO_TEST_SUITE_END(). The body of the test suite contains the test cases, which are defined 

by BOOST_AUTO_TEST function. Each boost auto test method is written to check only one member 

method of a class. The name of each test case consists of two parts separated by an underscore 

character. The first part represents the class name and the second part represents the name of the 

member method of that class under the test. The code template below describes the structure of 

written tests. 

BOOST_AUTO_TEST_SUITE(the name of the suit test) 
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//-------------------- test cases for object [Class Name] ------------// 
 
BOOST_AUTO_TEST_CASE(the name of the suite case [className_methodName]) { 
 
// instantiating the class if it is needed 
// prepare input for method 
// invoke the method of class 
//use boost_check to validate the returned value from method 
  
    BOOST_CHECK(returnedvalue==expectedvalue);//[class name] , [method 
name] test failure 
 
 
} 
 
BOOST_AUTO_TEST_SUITE_END() 

 

The BOOST_CHECK() method is used to validate the returned value from the method under test 

towards its expected value. if the given condition to this method is not satisfied, it prints the line 

number and the title of the test case in which the defect is recognized. The example below is an output 

of this method in the case of detecting some failure  

test.cpp(8): error in "[className_methodName]": check returnedValue==expectedValue failed 

This example shows that in the 8th line of test.cpp file a defect is recognized. The 

className_methodName specifies the name of the test suite.  It shows that the an unexpected 

condition, in which the retunerdValues is not equal to expectedValue,  has been detected by 

BOOST_CHECK() method. 
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2 How to Build ReSUS  

Resus project consists of three main namely: GUI, Core and Analyzer.  In addition, there is a small 

component, named regex checker, to examine the matching of Regular Expressions and input strings. 

The three main components are packed in a single Qt project as three subprojects. (See Figure 46. 

structure of the ReSUS main components in Qt) 

 

Figure 46. structure of the ReSUS main components in Qt 

 

2.1 Install pre-required Tools 
In order to build the components of the ReSUS Platform the following tools are mandatory. Please 

install them before start to build the ReSUS Platform from source code  

2.1.1  Install Qt 

Download and install Qt with msvc2012 32 bit from the following link: 

http://download.qt.io/official_releases/qt/5.2/5.2.0/qt-windows-opensource-5.2.0-msvc2012-x86-

offline.exe 

Qt is just an IDE which don’t offer built-in compiler tools. The compiler tools should be assigned to it 

after finishing the installation.  

During the Qt installation, please activate Source Components with checking the corresponding 

checkboxes (See Figure 47) 
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Figure 47. Select Source Components to get installed 

2.1.2  Install MSVC2010_32bit 

In our case, the 32 bit version of Microsoft Visual C++ compiler is required. The Microsoft Visual Studio 

2012 contains the required compiler for installed Qt. after installing the Microsoft Visual Studio 2012, 

you should restart your system.  

2.1.3  Configuring the compiler kits in Qt 

After restart, the Qt should automatically find the installed compiler. To check the configurations of Qt, 

open the Qt and follow these steps:  

 Select the Options from the Tools menu. 

 Select the Build & Run from left side of the appeared dialog box. 

 Select Kits tab  

The installed kit should be already visible in the list of the installed Kits (See Figure 48. Finding the 

MSVC2012 in the list of installed Kits of Qt) 
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Figure 48. Finding the MSVC2012 in the list of installed Kits of Qt 

2.1.4  Download and Install windows developer kit for windows 7  

In order to provide debug possibilities for Qt, installation of the Windows SDK for Windows 7 is 

recommended. It is available on the Microsoft website on the following link: 

https://www.microsoft.com/en-us/download/details.aspx?id=3138 

2.1.5  Download and install 32-bit version of Java Development Kit 7 

We have utilized the 32-bit version of Java Development Kit 7 for developing the GUI component of the 

ReSUS as an Eclipse plug-in. The used HDF5 libraries in GUI are also dependent to the 32-bit version of 

the Java.  This package is available in Oracle website under the following link:  

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html 

2.1.6  Download and install Eclipse 32-bit for Windows 

The 32-bit version of Eclipse for Windows can be downloaded from the official website of Eclipse. 

Notice that the Plug-in Development Environment (PDE) has to be included in the selected version of 

Eclipse.  

2.1.7  Download and install HDF Viewer  

Download the 32-bit version of HDF Viewer tool from the website of the HDF Group. We are using the 

Windows_VS_2012 which is available under the following internet address:  

http://www.hdfgroup.org/ftp/HDF5/hdf-java/current/bin/HDFView-2.11-win32-vs2012.zip 

 

Once the download is finished, unzip it and run the installer. It is important to remember the full path 

of the destination folder of installer for coming steps. In our case, it has be installed on the C:\Program 

Files (x86)\HDF_Group\HDFView\2.11.0 .  
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2.1.8  Download ReSUS  

The first step is to get the source code of the ReSUS. After downloading the source code, unzip it. In 

our case, we have extracted this file in the root directory of C drive.  

 Figure 49 shows the included folders within in the source package or ReSUS (in our case, it is stored 

under C:\resus_source).    

 

Figure 49. The Content of the ReSUS Source package 

 

The Charts, Core, Export and regexChecker folder contains subprojects of ReSUS. The GUI folder 

contains the source code of the Graphical User Interface for ReSUS which will be explained in next step. 

The other folders contain the required libraries which are needed for compiling the components of 

ReSUS. They are also assigned to the project with relative addresses in pro file of each subproject. 

 

2.2 Core  
In order to generate the Core part of the ReSUS Platform, perform the following steps: 

 Open the Qt Creator  

 Load the Content of the Core folder form ReSUS Source package into the Qt Creator (See Figure 

50) 
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Figure 50. Open ReSUS Core in Qt Creator 

 In some cases, after click on Open button in Open Dialog (Figure 50), the Qt Creator show you 

the Project Configuration page. In this page, uncheck the Debug check box and be sure that 

the Desktop Qt 5.1.0 MSVC2012 32bit is checked. Specify the destination folders to build the 

release files of Core and finally click on Configure Project button (Figure 51). 

 

Figure 51. Confiutre the Core project after opennin in Qt Creator 

 It should open the Core project in the Qt and make it available in Project Explorer part of the 

Qt Creator (See Figure 52) 
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Figure 52. Core project is opened in in Qt Creator 

 Right click on ReSUSCoreLib subproject and select build “ResusCoreLib” from opened context 

menu (Figure 53) 

 

Figure 53. Build the ResusCoreLib subproject 

 After successful build of the ResusCoreLib subproject, it is time to build the ResusCore 

subproject. This step is also similar to previous step. Just right click on the ResusCore 

subproject and select Build “ResusCore” from opened context menu (Figure 54) 
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Figure 54. Build the ResusCore subproject 

 Click on Projects button from the side bar of the Qt Creator and copy the content of the Build 

Directory text box into the windows explorer  

 

Figure 55. The path to the built Core project 

 Under the address of the Build Directory, open the ResusCore subfolder and go to the release 

folder. You will see the generated executable of the Core as resusCore.exe 

 Go to the folder of ReSUS Source package and copy the pcre3.dll and pcre3d.dll files from 

<ReSUS Source package>/prclib/bin into the <resus core build directory>/ ResusCore/release 
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Figure 56. Copy the PCRE dll files into the release folder of ResusCore project 

 Go to the Qt Creator and right click on Core. Select Close Project “Core” to close the Core 

project to (See Figure 57) 

 

Figure 57. Close the Core project in Qt 

 

2.3 Export Tool 
in this step, it will be shown how to compile the Export tool component of the ReSUS Platform. This 

component is also written in C++ and it is necessary to get opened in Qt Creator. Follow the steps below 

to compile and build the Export Tool:  
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1. Start the Qt Creator 

2. Open the File menu and select Open File or Project…  

 

Figure 58. Open File or Project from File menu 

3. In the Open File dialog box, go to the source package of the ReSUS, and select the Export.pro 

file under the Export folder (See Figure 59) and click on Open button 

 

Figure 59. Open Export Project in Qt Creator 

4. Select the Desktop Qt 5.1.0 MVC2012 32bit from the Configure Project tab, uncheck the 

Debug checkbox and specify the output path for Release files. click on Configure Project 

button to show the Export project in Project Explorer (Figure 60) 
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Figure 60. Configure the build of the Export project in Qt 

5. Click on the Export project in Project Explorer to expand it 

6. Right click on the ResusExportLib subproject and select Build “ResusExportLib” (See Figure 61) 

 

Figure 61. Build the ResusExportLib subproject 

7. Right click on the ResusExport subproject and select Build “ResusExport” from the opened 

context menu (See) 

 

Figure 62. Build the ReSUSExport subproject 

8. After successful build of the ResusExport subproject, open the Build directory of the Export 

project (See Figure 63) and copy the Path into the clipboard 
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Figure 63. The path to the Build directory of ResusExport project 

9. open the Qt 5.2.0 32-bit for Desktop (MSVC2012) Command Prompt form the all programs in 

window start menu under the following address: Start Menu>All Programs>Qt 5.2.0>5.2.0> 

MSVC 2012 (32-bi)> Qt 5.2.0 32-bit for Desktop (MSVC 2012)  

10. Figure 64 depicts the entering into the Build directory of Export project (copied into the 

clipboard from step 8) and changing into the release folder 

 

Figure 64. The ouptut folder of Export project in release mode 

11. type windeployqt . and press Enter key (See Figure 65) in order to start the deployment process 

of Export project for windows. Be sure that you have entered the dot (.) after this command 

before pressing Enter key 
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Figure 65. Using windeployqt command with a dot as argument to copy required files for stand aloe 

execution of ReSUS Export 

12. the deployment process for windows should be finished without errors as same as presented 

in Figure 66. 

 

Figure 66. Deployment process finished without any errors 

13. close the Export project in Qt Creator 

  

2.4 Chart Tool 
In order to Compile and deploy the Chart tool of the ReSUS Platform perform the following steps:  

 open the Qt Creator. Right click on Project Explorer (See Figure 67) and select Load Project  
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Figure 67. Right click in project exploer and selet Load Project to apear open dialog 

 open the Chart.pro file from the Charts folder in source package of the ReSUS Platform (See 

Figure 68) 

 

Figure 68. Load Project dialog to select the Chart.pro from ReSUS Source package 

 in the Configure Project page, uncheck the Release checkbox from Desktop Qt 5.2.0 

MSVC2012 32bit (Figure 69) and click on Configure Project button 
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Figure 69. Configure the output of the Chart project in Debut mode 

 right click on ResusChartLib subproject in the Project Explorer and select Build 

“ResusChartsLib” to build this subproject (See Figure 70) 

 

Figure 70. Build ResusChartLib subproject in Debut mode 

 right click on ResusCharts subproject and click on Build “ResusCharts” (See Figure 71) 

 

Figure 71. Build ResusChart subproject in Debut mode 

 click on Projects button from Qt Creator side bar and copy the path of the Build Directory into 

the clipboard (See Figure 72) 
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Figure 72. Copy the path of the Build directory into clipboard 

 open the Qt Command Prompt for MSVC2012 from the Start Menu > all programs> Qt 5.2.0> 

5.2.0 > MSVC2012 (32-bit) > Qt 5.2.0 32-bit for Desktop (MSVC 2012) 

 in Command Prompt, change the directory into the Build directory of Chart project (Figure 73) 

 

Figure 73. Changing the current directory into the Build directory of Chart 

 in command prompt window, type cd ResusCharts and press Enter key 

 in command prompt windows, type cd debug and press Enter key 

 type windeployqt . and press Enter key (Figure 69). Don’t forget to enter the dot (.) after 

windeployqt 
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Figure 74. Deploying the output of the ResusChart for windows with windeployqt . command 

 Figure 75 illustrates the successful of deployment process  

 

Figure 75. Successful execution of the Chart tool deployment 

 Close the Chart project in Qt Creator  

 Copy the qwt.dll and qwtd.dll from <ReSUS Source package>/qwt-6.1.0/lib and paste it into 

the <resus charts build path>/ResusCharts/debug folder 
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Figure 76. Copy and paste the QWT dll files into the debug folder of Charts project 

  

 Copy the Qt5OpenGLd.dll, Qt5PrintSupportd.dll and Qt5Svgd.dll from <ReSUS Source 

package>/dlls and paste it into the <resus charts build path>/ResusCharts/debug (See Figure 

77)  

 

Figure 77. Copy and pate the additional dll files into the debug folder under build path of the Chart tool 

 

 

2.5 RegexChecker  
RegexChecker is a simple program which is delivered within the ReSUS Platform. The source code of 

this project is available under the source package of the ReSUS Platform. In order to build and deploy 

the RegexChecker follow the instructions below: 
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1. Open Qt Creator and load the regexChecker.pro file which is located under <ReSUS Source 

package>/regexChecker/RegexChecker/  

2. Configure the project for Release mode by unchecking the Debug setting from Configure 

Project page (See Figure 78) and click on Configure Project button. 

 

Figure 78. Configure the release mode of the regexChecker project 

3. Right click on the RegexChecker Project in Project Explorer and select Build from opened 

context menu (Figure 79).  

 

Figure 79. Build the RegexChecker project 

4. copy the pcre3.dll and pcre3d.dll from <ReSUS Source package>/pcrelib/bin into the 

<regexChecker build output>/release/ folder (See Figure 80) 
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Figure 80. Copy the pcre dll files into release folder of regexChecker 

5. open the Qt Command Prompt for MSVC2012 from the Start Menu>all programs> Qt 5.2.0 > 

5.2.0 > MSVC2012 (32-bit) > Qt 5.2.0 32-bit for Desktop (MSVC 2012) 

6. change the directory into the Build directory of RegexChecker and go to the release folder 

(Figure 81) 

 

Figure 81. Open release folder of RegexChecker project under the QT command prompt tool for MSVC2012 

32-bit 

7. type windeployqt . and press Enter key (Figure 82Figure 69). Don’t forget to type the dot (.) 

after windeployqt  
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Figure 82. Execute windeployqt command with a dot to generate deployable version of  RegexChecker 

Figure 83 depicts the successful finish of windeployqt command 

 

Figure 83. Deployment of RegexChecker finished successfully 

2.6 GUI 
This chapter describes the prepare, compile and deployment of the Graphical User Interface of ReSUS.  

Graphical User Interface (GUI) 

The user interface is developed as Eclipse Plugin (Clayberg, 2008). The Logic Example project from 

Graphical Editing Framework (Rubel, 2011) is used as the start point of developing the Graphical User 

Interface. The ReSUS Platform is developed by changing and extending the used concept in the source 

code of Logic Example.  

ReSUS Plugin 

In this part, the structure and packages of the source project of the ReSUS Graphical User Interface will 

be introduced. 
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2.6.1  Plugin Development Environment (PDE) 

The Designer Tool of the ReSUS Platform is implemented as Eclipse Plugin. One should have the 

knowledge about the Eclipse Plugins and Graphical Editing Framework to understand the architecture 

of the ReSUS Platform. 

 

2.7 Setup  
The Plugin Development Environment (PDE) (Foundation, 2016) is equipped with tools to create, 

develop, test, debug, build and deploy Eclipse plugins. This framework is a part of the Eclipse SDK and 

is available to downloaded from the Eclipse project downloads page (http://download.eclipse.org).   

2.8 Import 
The Graphical User Interface of ReSUS is also a PDE project which can be opened, manipulated and 

extended by eclipse. The following steps are required to import and open the ReSUS Graphical User 

Interface in Eclipse: 

 Select File-> Import to appear the Import wizard 

 Select Existing Project into Workspace from General, and click on Next button (See Figure 84) 

 

Figure 84. Existing Project into Workspace  

 Choose Select root directory and click Browse to locate the directory containing the ReSUS 

GUI project 

 Under Projects select the de.clausthal.tu.ielf.resus (Figure 85) 
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Figure 85. Select de.clausthal.tu.ielf.resus 

 Click Finish to start the import (See Figure 86) 

 

Figure 86. The project de.clausthal.tu.ielf.resus is imported 
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2.9 Graphical Modeling Framework 
The Graphical Modeling Framework GEF SDK is a prerequisite component for compiling the ReSUS GUI 

by Eclipse. If it is not installed, follow the steps below to install it (Figure 6): 

 On the menu bar of Eclipse, click Help > Software Updates  

 Select the all available sites from the Work with combo box 

 Expand the Modeling section and select the Graphical Editing Framework GEF SDK 

 Click Next  

 Accept the agreements and click install 

 

Figure 87. Install Graphical Editing Framework GEF SDK 

The installed Graphical Editing Framework GEF SDK should be attached to the dependencies of the 

ReSUS Graphical Interface project:  

 Expand the META-INF folder of the imported ReSUS Graphical User Interface Project and 

double click on the MANIFEST.MF to open the plugin manifest editor 

 Click on the Dependencies tab   

 Click on Add button  

 Type org.eclipse.gef in the Select a Plugin textbox on the Plugin Selection dialog 

 Select org.eclipse.gef from the filtered list  

 Click Ok 
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Figure 88. Adding GEF SDK to the Dependencies of the Project 

The HDF5 jar files and the Apache Commons Mathematics Library should also be in the attached 

libraries of the ReSUS GUI Project under lib folder. If these jar files are not attached to the project, 

attach them with the following instruction: 

 Use Import>File System to import the jar files into the ReSUS GUI plugin project, save them in 

the /lib directory 

 Use Add... to add the jars to the classpath section of the plugin.xml>Runtime tab 

 Use New... to add "." library back (with no quotes) 

 Make sure that the binary build exports the new jar file. See the plugin.xml>Build tab 

 Save the changes in the MANIFEST.TM file 
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Figure 89. Registration of jar libraries in the runtime page of the plugin 

In order to bind the HDF5 native libraries (DLL files) to the eclipse project, java.library.path should be 

set to the directory that contains the HDF5 DLL files. This should be specified as VM argument using 

the –D switch in the run configuration of the project by Eclipse. Java Virtual Machine will search for DLL 

files in the given path of the following specification example: 

  

–Djava.library.path=”D:\resus\resusuInstallation\ReSUS_win32\lib”   
 

Figure 90 depicts how to access to the VM argument by Eclipse and add the specifications.  

 

Figure 90. Required steps to load the HDF5 jar files and native libraries  
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2.10 Export the RESUS GUI 
 Right click on GUI project in Project Explorer of Eclipse and click on Export (See Figure 91)  

 

Figure 91. Export the GUI of Resus 

 Select Deployable plug-ins and fragments from Plug-in Development in Export dialog box and 

click on Next button  
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Figure 92. Select deployable plug-ins and fragments 

 Brows a directory in Destination tab and click on Finish button (See Figure 93) 

 

Figure 93. Select the destination directory and click on Finish to export the de.clausthal.tu.ielf.resus project  

 Eclipse generates a far file under plugins folder in the submitted Directory as Destination.  
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Figure 94. Exported plugin for Eclipse 

2.11 Creating the Software Package for the ReSUS Platform 
In order to build the ReSUS project from these three sub components, they should be built and 

compiled as three separate projects. At the end the compiled files should be placed in right place in 

the following structure to make the resus operational. 

  Create a directory with the name ReSUS _win32 and create the following sub directories under 

this directory 

a. core  

b. export 

c. chart 

d. regex 

e. workspace 

  Copy the content of release folder of Core, Export and regex subprojects into the newly 

created sub folders. For Chart tool the contents of the debug folder should be copied into the 

chart folder under ReSUS_win32 folder 

 Copy the pcre.dll and pcre.lib from the installation package of the PCRE into the core folder as 

well as regex folder under the Resus_win32 

 Create a folder named eclipse under ReSUS_win32. Download Eclipse 32 bit for Windows and 

unzip it into this newly created folder. Copy the generated plugin jar file for GUI form step 

2.10.Export the RESUS GUI into the plugins folder of the newly generated eclipse folder 

 Go to Program Files folder and find the path which is used to install HDF5 View project. It 

should be normally in the following path:  

C:\Program Files\HDF_Group\HDFView\2.11.0\ 

 Open the bin folder and copy the jre7 folder and paste it under ReSUS_win32  

 Open the HDF5 folder again and copy the lib folder from the installation folder of the HDF View 

tool and  paste it inside the ReSUS_win32 folder 

 Create a bat file under ReSUS_win32 folder, name it startReSUS.bat and fill it with the following 

text: 

echo.Setting environment 

set RESUS_HOME=%CD% 

start eclipse\eclipse.exe  -vm "%RESUS_HOME%\jre7\bin\javaw.exe"  -vmargs -

Dosgi.requiredJavaVersion=1.6  -Xms40m -Xmx512m -Djava.library.path="%RESUS_HOME%\lib"  

exit /b 0  

 run the startReSUS.bat file. It should open the Eclipse with the welcome page.  Click on the 

Workbench button (top right) to open the Eclipse (See Figure 95) 
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Figure 95. Welcome page of Eclipse after installing the Resus Plugin 

 

 Open the Open perspective window in Eclipse under Window>Perspective>open 

Perspective>Other… (See Figure 96) 

 

Figure 96. activating the ReSUS Model Designer perspective 

 Select the ReSUS Model Designer from the viewed list in Open Perspective dialog and click on 

OK button (See Figure 97) 



103 

 

 

Figure 97. Select Resus Model Designer 

 

 Open the Preferences of Eclipse from Window Menu. Open the General> Startaup and 

Shutdown in the Preferences dialog (See Figure 98) 

 

Figure 98. Uncheck Refresh workspace on startup 

 Uncheck the Refresh workspace on startup and click Ok 

 ReSUS is Ready to Use 
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